# Table of Contents

5 Acknowledgments

7 Chapter 1: Introduction to MapSAR

7 MapSAR Features
8 When to Use MapSAR
9 An Overview of How to Use MapSAR
12 System Requirements for MapSAR
12 Prerequisites
13 MapSAR First-Time Setup
18 How MapSAR Works
19 Entering Incident Information
20 What Makes Up an Assignment?
21 Maps
22 Data Driven Pages (Team Assignments)
22 MapSAR Folder Structure
23 MapSAR Folders
23 Layer Files Local
23 The Tools Folder
23 MapSAR New Incident Directory Structure

27 Chapter 2: Tutorial

27 MapSAR Workflow: Outline for Creating a Search Incident

29 MapSAR: Beginning a New Incident

Opening the New_Incident Folder
Locating Your SAR and Loading Basemaps
Entering Incident Information
The Incident Group
Reporting Party
Incident Data
Entering the PLS
Establishing PLS by Eyewitness Verbal Description
Establishing PLS by Coordinate Values
Operational Period

43 Incident Assets

Adding Incident Assets
Add Assets to the Incident:

45 Segments Group

MapSAR—Creating Search Segments
Creating Search Segments Using the Scratch Lines Tool
Table of Contents (continued)

Hand Drawing Segments
Construct Using Buffer
Adding Data to Each Segment

55 Teams Group
Adding Teams to the Incident
Team Members

57 Assignment Group
MapSAR—Creating Search Assignments
Assignments versus Segments
Creating Assignments
Using a Segment Shape as a Template for the Assignment
Drawing an Assignment
Construct Using Buffer
Entering Data Associated with the Assignment

63 Printing
Printing Data Driven Pages
Printing with Only a Single Assignment Visible per Page
Printing Other Maps
Basic Template Setup for All Layouts

Tabloid Landscape
Mutiframe Documents: Additional Steps
SitStat Maps (Situation Status)

84 GPS Tracks and Routes
Importing GPX Files (Waypoints, Tracks, Routes)
Importing Tracks or Waypoints
Drawing Routes

90 MapSAR—Reports
92 Subject Found

96 Chapter 3: Additional MapSAR Features
96 Creating a Search Boundary
Using Scratch Lines
Adding Hand-Drawn Scratch Lines to the Routes Layer

104 Radio Log

106 Chapter 4: Advanced Skills
106 Georeferencing Aerial/Satellite Photographs
Obtain an Image to Georeference
Add the Georeferencing Toolbar
Add the Photo to MapSAR
Table of Contents (continued)

116  Chapter 5: Troubleshooting
     116  Versions
          How do I know which version of MapSAR I’m running?
          I’m getting a strange error after upgrading my version of MapSAR (I had a previous installation).
     119  Editing
          I’ve started an editing session and don’t see what I expected to.
     125  Problems Running Update Domains
          I receive an error message when running Update Domains.

132  Appendixes
     132  Appendix 1: Attribute Assistant in MapSAR
     134  Appendix 2: Creating Bookmarks
          Load Your Bookmarks into Each Template
          Creating the Customized New_Incident File
     140  Appendix 3: Cell Phone Pings
          If You Have the Cell Tower Coordinates
          If You Have the Cell Tower Address
          Drawing a Signal Range Circle Around the Cell Tower
          Hand Drawing a Circle Using the X,Y and Radius Functions
          Use the Euclidean Model to Generate a Signal Circle Around the Cell Tower
     153  Appendix 4: Resources and Support
          Resources
     155  Appendix 5: Glossary and Acronyms
     157  Appendix 6: References
The MapSAR application for ArcGIS grew out of a critical need to more effectively integrate GIS into search and rescue (SAR). A number of experienced SAR people had been working on this problem, but we were scattered across the country—and even the world—and had no idea what others in this field were doing. Fortunately, several of us were put in contact with Tom Patterson at Esri. Tom and other Esri developers had been closely involved in developing a GIS capability for wildland fire fighting and creating Fire Incident Mapping Tool (FIMT), which works with ArcGIS for Desktop. That experience and tool became our model to capture the SAR workflow and associated geospatial information into one program.

A small workgroup formed and met several times to outline our goals and approaches to the problem. The MapSAR workgroup is an all-volunteer effort. Jon Pedder, of Sierra Madre Search and Rescue (SMSR), became the lead developer of what came to be called MapSAR. Pedder wrote much of this while commuting by train into work—the unpredictable bounces of the train providing additional challenges to the coding effort. Arnold Gaffrey, also of SMSR, provided further development advice and design. Art Fortini and the entire Sierra Madre team were instrumental in developing the workflow and testing it on live exercises and, later, actual SARs.

Other members of the workgroup provided invaluable help and guidance: George Durkee, park ranger and adjunct instructor for SAR at Columbia College in Sonora, California; Vanessa Glynn-Linaris, a Federal Emergency Management Agency (FEMA) Hazards US (HAZUS) instructor and owner of GeoRevs, LLC, a GIS consulting firm; Paul Doherty, formerly of Yosemite SAR and now at Esri; Don Ferguson, PhD, of the Mountaineer Area Rescue Group in West Virginia; Richard Laing, team manager, Ridge Meadows Search and Rescue; and Peter Lindstrom of the National Park Service.

None of this could have happened had not a number of employees at Esri become excited about this project and volunteered their expertise and hundreds of hours of their time: Tom Patterson, Edan Cain, Matthew Baker, Doug Morgenthaler, Jennifer Schottke, Liz Sarow, and Brenda Martinez. Their constant enthusiasm and dedication is a major contribution to our ultimate goal of saving lives.

Others in the SAR and GIS community have helped enormously: John Amrhein, emergency services coordinator, San Bernardino
County Sheriff’s Department; Lora Peppers, park ranger, Shenandoah National Park; John Dill, Yosemite SAR; Dan Hurlbert, GIS specialist—Spatial Mapping and Analysis Program, Shenandoah National Park; Bob Koester, author of the core work *Lost Person Behavior: A Search and Rescue Guide on Where to Look—for Land, Air, and Water*; Ken Phillips, chief of emergency services, Grand Canyon National Park; and Victoria Smith-Campbell, GIS coordinator, Colorado Division of Emergency Management.

Peter O’Rourke and Rebecca Harned, of the National Alliance for Public Safety GIS Foundation, recognized Pedder and the MapSAR workgroup for our contribution to the national SAR effort. They continue to offer their support and resources to further our education efforts.

MapSAR User’s Manual was written by Pedder and Gaffrey. Additional writing and editing was done by Durkee and Glynn-Linaris. Fortini and Laing provided the screen shot illustrations.

Search and rescue will always be an arduous and often dangerous pursuit. It is our hope, though, that MapSAR and this manual will contribute to making that effort more effective in bringing the lost and injured safely back to their homes and families.
Chapter 1: Introduction to MapSAR

MapSAR is a tool that runs with ArcGIS 10 for Desktop to store geospatial information, enabling search and rescue (SAR) maps to be generated, stored, and printed quickly so that search teams can get out the door faster to look for the missing person. MapSAR was created by a team of geographic information system (GIS) and SAR professionals from Sierra Madre Search and Rescue Team, Esri, Sequoia and Kings Canyon National Park, Yosemite National Park, Grand Canyon National Park, and the Mountaineer Rescue Group. The overall goal was to create a tool that would meet the mapping needs of operations and planning staff on large-scale searches. MapSAR runs with ArcGIS 10 for Desktop. It will run with any license level from Basic (formerly ArcView) and above (See Determine Which ArcGIS for Desktop License Level Is Right for You at esri.com/software/arçgis/arçgis-for-desktop/pricing).

It is also important to note that both MapSAR and this manual are works in progress. Field experience and need will guide future releases. The PDF version of the manual will be updated occasionally to reflect overlooked details and improve workflow routines.

MapSAR Features

• Maps for all field teams can be quickly and automatically generated, then printed with just a few clicks of the mouse.

• All the data is stored in layers that can be individually turned on or off. This makes it easy to declutter a map without losing information as well as customize and visualize the information necessary for planning strategy.

• For those wanting a simple mapping program and who prefer not to become a GIS specialist (GSS), MapSAR, despite all its power, can still be used. You simply work with two items from the table of contents (TOC) and ignore everything else.

• MapSAR does not require you to be connected to the Internet, assuming you have all your data on the hard drive or portable storage.

• Search segments and assignments can be created quickly and easily using established SAR workflows.

• All geospatial and significant incident data is permanently stored for use throughout the SAR and afterward, should it be
needed for after-action review or training or if the subject is not found and the search is to be resumed at a later time.

- Large-scale briefing maps with relevant data layers turned on or off can be easily generated.

- The locations of the Point Last Seen (PLS), Incident Command Post (ICP), all clues, and all field teams are stored in a georeferenced database.

- GPS tracks can be added to the map when search teams return from the field, or the team can sketch in a best estimate of their route.

- A behind-the-scenes database relates team members, team numbers, search assignments, clue locations, segment numbers, and so forth. No database programming is required.

- Aerial imagery can be superimposed on the basemap.

- And best of all, it’s user-friendly!

**When to Use MapSAR**

Most searches are completed successfully within the first Operational Period (OP), frequently during the hasty search phase. When the search is completed quickly, the amount of data generated is comparatively small. Furthermore, because the area is familiar to the search teams, the need for maps is minimal. The problem, of course, is that at the outset of a search, you don’t know if the incident will be resolved quickly or become a multiday operation.

Even on simple searches, documenting clue locations, track logs of field teams, and the location where the subject was found, can be important. In such cases, MapSAR can be used, but only the Clues and GPS_Tracks_and_Routes layers need to be used. If you choose to, you can also populate other parts of the database, such as who was on which field team, but for searches that are resolved quickly, this level of detail is seldom required.

Central to the MapSAR workgroup strategy is to create an effective GIS capability among all team members. This means that the first on scene can be easily trained to use ArcGIS Explorer, Esri’s free mapping software, to capture the initial geospatial information of a SAR: Initial Planning Points (IPP), segments, assignments, and assets. This can then be exported to ArcGIS for Desktop if the search expands and a person trained in MapSAR is brought in. (See Using GIS in Wildland Search and Rescue for training in both GIS basics and using ArcGIS Explorer on SARs.)

When a search enters the second or third operational period, additional resources are called in, and the search is scaled up. The sheer volume of information that needs to be processed at that point requires a much more organized approach. MapSAR is the tool to manage that volume of geospatial data.
It is important to emphasize the limits of MapSAR. MapSAR has the ability to store more than just geospatial information. It can also capture information on the subject, the reporting party, the composition of field teams, and so on. The database is powerful enough to store and organize all the data generated in a large search, but in the early stages of MapSAR development, it was quickly realized that this can be a limitation. We didn’t want the MapSAR technician to become a choke point for information flow and thus cause the search management effort to get bogged down. Consequently, even though the ArcGIS database could be used to log in searchers as they arrive at the command post, this would be a poor use of the GIS person’s time. As such, it is not recommended.

Likewise, ArcGIS 10 for Desktop does not have the ability to directly download track logs from a GPS. However, ArcGIS 10.1 for Desktop will be able to directly download GPX files. For ArcGIS 10 users, GPS data can be downloaded to another computer and brought into MapSAR quite easily in GPX format, using one of the MapSAR tools. Again, to prevent the MapSAR technician from becoming a choke point in the incident, we strongly encourage that this task be assigned to a different person. Of course, the software used to download the GPS data can also be loaded on the same computer as MapSAR.

An Overview of How to Use MapSAR

The MapSAR structure consists of several numbered layers or groups, which you’ll see in the MapSAR Table Of Contents window after installation in the next step (MapSAR First Time Setup):

1. **Incident_Group**

   This group includes Reporting Party (RP), Subject, PLS, the timing of the Operational Periods, and the Communications Plan. For small searches, this information is optional and not required for MapSAR to function, but at a minimum, the PLS should be well documented. For the most part, this layer contains text data; the only data in this layer that is mapped—that is geospatial in nature—is the PLS and the location where the subject was found.

2. **Incident_Assets**

   Incident assets refer to geospatially located assets such as the locations of the ICP, helibases, and so on. For small searches, this information is optional and not required for MapSAR to function.

3. **Assignments_Group**

   The assignments group stores information on where field teams are assigned to search. Note that we differentiate between search assignments and search segments. A
segment may be searched more than once, but each assignment given to a field team is unique. This will be discussed in greater detail in Chapter 2: Tutorial in the Assignments section. For small searches, where the teams are staying on trails, roads, or streams, creating assignments by drawing a squiggly line on the map is extremely easy. If desired, MapSAR will automatically draw a buffer around the line that represents the trail/road/stream to show the effective sweep width.

4. **Teams_Group**

This layer stores information on who is in the field, which team they’re with, what kind of a team they’re on, their radio call sign, and so forth. For small searches, this information is optional and not required for MapSAR to function. For larger searches, though, it’s a very useful tool for keeping track of personnel.

5. **Resource_Team_Status**

This layer is used to plot points showing the locations of field teams. Different symbols are used to indicate whether the team is on assignment, hunkering down for the night, awaiting pickup, and so forth. As with most of the features, MapSAR will function properly even if you choose not to enter this information.

6. **Clues**

MapSAR uses different symbols for different clue types. Physical clues, such as a water bottle, use one symbol; cell phone hits use another; and the Direction Finder signal strength symbol from a cell phone ping yet another. For physical clues, different colors are used to signify perceived relevance. Even on small searches, being able to place clues on the operations map is useful.

7. **GPS_Tracks_And_Routes**

This is where track logs from various resources are stored. To make the map more readable, track logs from field teams and aircraft can be turned on or off separately.

8. **Segments_Group**

Once the search becomes large enough where you need to create segments, this tool becomes invaluable. Several drawing tools are available to simplify the task. In addition to simple geometric shapes and freehand tools, there are also autocomplete tools that will use the edge of an existing search segment as the boundary of the one you’re currently drawing—no more need to trace over an existing line, and no more sloppy boundaries between segments!
9–13 Other Layers

These include primarily text-based information:

- **The Air_Operations** layer (9) is a table that keeps track of deployments and extractions where air assets are used.

- **The Radio_Log** layer (10) can be used to store radio traffic that has been tabulated elsewhere. You don’t want the MapSAR technician to get bogged down keeping the radio log, but if the SAR dispatcher keeps a running log in a spreadsheet, the data can be easily imported into MapSAR for later review and archival purposes.

- **Hidden_Layers_Admin_Only** (11) are hidden to prevent the user from accessing them. They are necessary for MapSAR to run, but unless you’re a GIS expert, ignore them.

- **The Reports_Group** layer (12) also requires no user intervention; its presence in the TOC simply allows the reporting templates to draw data from the other items in the table of contents.

- **The Incident_Analysis** layer (13) is used to draw circles on the map denoting typical distances traveled by different types of missing subjects. It is also used to define the outer limits of the search area and thus define the rest of the world.

14. Base_Data_Group

This is where additional basemap layers are stored. For example, if you want to add aerial photos or overlay a USDA Forest Service (USFS) map onto your topo map, this is where the additional layers would be placed. Since this type of information covers a wide area, it is important that they be located near the bottom of the layer stack. If you put them near the top, they will hide the underlying layers and thus make things like clues and search segments invisible.

- **The Basemap layer** is the primary image upon which all other information will be stacked. For most searches, this will be a digital US Geological Survey (USGS) quad of the search area. As the name implies, the basemap is placed as the bottom layer, with other data layers over it. For small searches where limited resources are used and documentation needs are minimal, the Basemap layer may be all you need. A basemap is an essential part of your preplanning effort and should be included in your Minimum Essential Dataset.

MapSAR has the simplicity to be used on small searches to keep track of hasty teams, but it also has the capability of running multiday, mutual-aid SARs covering large areas. As your needs expand, more data layers can be added and you can begin using different tables, such as Assets, Teams, or Air Operations.
**System Requirements for MapSAR**

MapSAR will work for any license level of ArcGIS 10 for Desktop. Check these Esri websites to determine whether your system will run ArcGIS:

1. **Hardware**

   For complete information, please see Esri’s website: [esri.com/AG10systemrequirements](esri.com/AG10systemrequirements)

   You should run this Esri utility to check your computer’s ability to run ArcGIS: [http://cyri.systemrequirementslab.com/cyri-if/1186/10913](http://cyri.systemrequirementslab.com/cyri-if/1186/10913)

2. **Software**

   You’ll need a copy of Esri’s ArcGIS 10 for Desktop, with service packs installed to Service Pack 3 (SP3) and a license level of Basic (formerly ArcView) or higher.

   For home and noncommercial use, Esri also offers Basic with a number of extension licenses at a very low yearly subscription rate. Get more information at [esri.com/arcgis-for-home/common-questions.html](esri.com/arcgis-for-home/common-questions.html).

   Nonprofit organizations can apply to Esri for a software grant: [esri.com/nonprofit/faq.html](esri.com/nonprofit/faq.html)

   The following Microsoft patch is recommended, but not required, when using ArcGIS for Desktop, ArCInfo Workstation, ArcGIS Engine, or ArcReader on Microsoft Vista or Windows 7: [esri.com/AG10systemrequirements](esri.com/AG10systemrequirements)

---

**Prerequisites**

MapSAR will work with any license level of ArcGIS 10 for Desktop. Successful use requires a basic familiarity with ArcGIS and some editing skills. You can obtain introductory tutorials for ArcGIS 10 for Desktop from [http://training.esri.com/gateway/index.cfm](http://training.esri.com/gateway/index.cfm). There is also a good SAR-specific tutorial and practice dataset in the publication *Using GIS for Wildland Search and Rescue*, available as a free download from [MapSAR.net](MapSAR.net).

1. **Minimum Essential Dataset**

   One of the advantages of ArcGIS 10 for Desktop and MapSAR is that it is designed to work without a connection to the Internet. To do so effectively—and well ahead of your first SAR using GIS—it is critical that your team assemble and practice using the geospatial data you’ll need to better plan and visualize the SARs in your operational area. The files you assemble to work from will be your Planning Minimum Essential Dataset (MED). For guidance on assembling an MED, see the chapter “Creating a Minimum Essential Dataset” in *Using GIS for Wildland Search and Rescue*. This is available as a free PDF download from [MapSAR.net](MapSAR.net).
2. Downloading MapSAR

The most current version of MapSAR is available from MapSAR.net. To install, follow the instructions in the next section, MapSAR First-Time Setup. Then follow the instructions to install the New Incident folder specific to your primary response Universal Transverse Mercator (UTM) zone. If you work in an area covering several zones, you should be prepared to change your New Incident folder to coincide with the area you’re working in and avoid possible spatial geospatial distortions as you bring data in.

MapSAR First-Time Setup

1. Download

Download the MapSAR.zip file from MapSAR.net to your root drive at C:\.

2. Installation

   A. Extract: Use any compression tool you’re familiar with or prefer, such as WinZip, 7-Zip, or WinRAR. For all examples in this manual, the Windows default compression utility is used, as it creates well-compressed files that are easily extracted into a single folder.

   (1) Use the compression utility to extract the MapSAR.zip package and place it at the root of your C:\ drive so that you have C:\MapSAR and the folder structure shown in figure 1-4. It is critical that you have this path from the root drive (C:\). Several MapSAR functions use the C:\MapSAR path as a reference, and the tool won’t run properly if the path is wrong.

   (2) To extract, right-click MapSAR.zip and choose Open With > Compressed (zipped) Folders.

   Figure 1-1
(3) A new window will open with a MapSAR folder inside. Under Folder Tasks, choose Extract all files, and the Extraction Wizard will launch. Click Next.

(4) In the Select a folder to extract files to box, enter “C:\” and click Next and then Finish when prompted.

B. Shortcut: For easy access to MapSAR, make a shortcut of C:\MapSAR and place it on your desktop.

(1) To create a desktop shortcut, from Windows Explorer, right-click the MapSAR folder, choose Send To > Desktop Shortcut. An icon will be placed on your desktop that will take you to the MapSAR folder.
(2) After extracting MapSAR.zip, you should see this file structure:

![File Structure Image](image1)

Figure 1-4

3. **Installing Add-ins**

   A. Open the **Tools folder** (C:\MapSAR\Tools).

![Tools Folder Image](image2)

Figure 1-5

B. If you’re running Windows 7, right-click the ~LoadMapSARTools_Win7 batch file and select **Run as administrator**. For Windows XP users, simply **double-click ~LoadMapSARTools_XP**. This process registers all the necessary DLLs and installs the add-ins used throughout. If “failed to install” messages appear, the problem needs to be corrected prior to using MapSAR.

![Add-ins Installation Image](image3)

Figure 1-6

(1) Click **Yes** when asked whether the Windows Command Processor can make changes to this computer.

(2) You’ll see several dialog boxes. Click **OK** or **Install Add-in** when prompted.

4. **Customizing and Opening MapSAR**

To start a new search incident, you’ll need to extract the MapSAR New_Incident folder for the UTM zone you will be working in, then name it and add your incident data. The
compressed ZIP folders for UTM zones 10 through 19 North (those used for North America) have been provided. UTM zones can be found at [www.nps.gov/gis/gps/UTM_Zones_USA48.jpg](http://www.nps.gov/gis/gps/UTM_Zones_USA48.jpg). If you are working in an area outside the United States, email help@MapSAR.net for instructions on how to do this.

A. Open the MapSAR folder.
   
   **Note:** It is critical that MapSAR is located at the root of your C:\ drive, or else it won’t run correctly.

B. Next, open the *Localized Versions folder* and copy the appropriate UTM_xxN_New_Incident.zip file (based on your zone) from the *Localized Versions folder* to the C:\MapSAR directory.

C. Extract the UTM_xxN_New_Incident.zip file (that you just copied to C:\MapSAR) for each new SAR incident, and **rename** the New Incident folder using the following naming convention based on your incident information: <yyyymmdd_IncidentName>. If this is just the initial setup and you’re not running an exercise or actual SAR, you can leave the folder name as UTM_xxN_New_Incident.

   **Important:** Do not rename the SAR_Default.gdb file, or MapSAR will not work correctly!

   ![Figure 1-8](image)

D. Open the incident folder (renamed in the previous step as 20111013_SMSR_SearchForBilly).

   ![Figure 1-9](image)
E. Double-click **MapSAR.mxd**. This starts ArcGIS 10 for Desktop and opens the new incident.

F. The initial view of MapSAR—the window size will vary depending on the size of your monitor.

![Figure 1-10](image)

G. Verify that SAR.style is available.

   Select the **Customize menu** and then **Style Manager > Styles > Add style to list** and navigate to **C:\MapSAR\Tools\SAR.style > OPEN > OK > CLOSE**.

![Figure 1-11](image)

H. Set the correct azimuth for the editor.

1. Select **Editor > Options**.
(2.) On the Units tab, change the direction type to **North Azimuth**, and the directional units to **Decimal Degrees**; click **Apply > OK**.

Figure 1-12

Save changes to the MXD.

If you want to customize the map templates further for an area you often work in, refer to Appendix 2 on how to create customized bookmarks and repackage your new incident files.

**How MapSAR Works**

For the following section, it’s best to have MapSAR open so you can see how it’s organized. If you haven’t already, refer to and carry out steps 1 through 4 in the section MapSAR First-Time Setup. After reading the section, you may want to try the step-by-step ArcGIS and MapSAR exercises and data provided in Using GIS for Wildland Search and Rescue.

MapSAR was designed to quickly and efficiently produce maps for search and rescue operations. It is not a search management tool. The intent is to provide a data model that can be used to easily produce maps for briefing, planning, operations, and teams, then quickly get those teams into the field with the information they need to carry out their assignments.

**Central to MapSAR is the concept that assignments are unique.** Assignments are created and executed only once. Every assignment must have a unique assignment number. This assignment number is generated automatically after the MapSAR technician assigns the first number (usually “1”). MapSAR will automatically fill in “2” when the next assignment is created. You should not override this or use anything other than a whole number—no letters, dashes, special characters, and so forth.
Utilizing assignments makes it easy to provide a map for each team showing its individual task for that operational period.

MapSAR, then, requires a slightly different way of creating an SAR workflow than what some teams are used to. Many operations first create search segments, then assign teams to those segments. If they’re using GIS, they often just add a field for each team searching that segment. MapSAR can create both a segment and an assignment as a spatial file. You don’t need to create a segment for MapSAR to work, but you do need to draw an assignment area for other components to work correctly. The assignment approach works well in the early hasty search stage of an SAR. Later, as the search ramps up, segments can be created and the entire segment can be quickly converted to an assignment. If your team chooses to work from a segment approach and has absolutely no need to treat them as assignments, you can use a workaround to create your segments in the assignments layer so that MapSAR will still work properly—simply ignore the segments layer. You just need to remember that this is the approach you have chosen to use and what is listed as assignments are actually your segments.

This is a subtle but—for the purposes of how MapSAR stores and keeps track of a SAR—very important distinction. You need to practice at least 10 tabletop SARs to see how either approach fits into your workflow and evaluate which approach works best for your team.

MapSAR stores values from the PLS, Clues, Operational Period, Teams, Assignments, and Search Segments fields in the database domains (ArcMap refers to value lists as domains). These values are read from the associated tables and are then available through the use of drop-down menus throughout the system. This design is important, as it keeps data entry quick, easy, and accurate. The Update Domains tool is used to update the domains values (i.e., share data among various value lists) and must be manually executed whenever new records are added to any of those layers or their associated tables.

Figure 1-13

**Entering Incident Information**

Incident information is entered into attribute tables:

1. In the Table of Contents window, click the plus sign (+) to expand the group you want to enter information for. Access a group’s attribute table by right-clicking that layer in the TOC, then select Open Attribute Table from the menu. In the header where the field names are, each field highlighted in yellow is to be entered by the MapSAR technician; fields in gray are joined fields and will display data as information is
entered from other tables after using the Updates Domains tool. Do not enter values in the gray fields.

MapSAR is also configured so that, for some data, a pop-up form appears when you establish a point, polygon, or line on the map. For instance, when establishing PLS (or drawing an assignment or segment), instead of right-clicking the layer in the TOC as above, you need to fill in the form when it pops up. There may be other attribute tables you’ll find the pop-up form useful for. To activate a pop-up form that doesn’t appear by default, check that layer in the Attribute box. While in an editing session: Editor > Options > Attributes tab, then check the form you want to pop up and edit. Note that some are checked by default. With experience, you’ll determine the best choice to make your workflow easier.

Some field names have symbols (*, +, #, or @). Fields marked with an asterisk (*) requires a unique value to be entered. Fields marked with a plus sign (+) are drop-down menus that use data from other tables. The number sign (#) means that the information is required when entering data. The at sign (@) means the value is entered and increased automatically after the first value is entered.

2. To begin entering data, start an editing session by clicking the Editor menu, then click Start Editing.

3. For example, when you enter information for a clue, enter the assignment number of the team that found the clue. That entry then automatically enters (autopopulates) the team and operational period so that the information is accurately recorded and can be easily queried.

![Figure 1-14](image)

**What Makes Up an Assignment?**

- **Assignment number**—Requires a unique numeric value (After the first value is filled in, it automatically increases incrementally by 1 as each new assignment is created.)
- **Team**—Appears in a drop-down menu after you fill in the Team feature class and run the Update Domains tool
- **Operational Period**—Appears in a drop-down menu after you fill in the Operational Period feature class and run the Update Domains tool
- **Search Area**—A polygon created with the drawing tool chosen in Assignments during an editing session (This is not to be confused with a search segment; this is the geographic area for the assignment or task to take place.)
• **Search Description**—A short text field describing the area to be searched

You build an assignment from values entered into the attribute tables of its associated layers. For instance, previously filling in the Operational Periods makes that information available when creating an assignment. An assignment can be drawn and given its unique number without having a team assigned to it. A team can be added later when assignments are given to the teams. This speeds up the planning process. You can have your assignments mapped and ready to go—waiting only for your teams to arrive, where you then fill in that information and create customized maps for them to take into the field.

When an assignment has been completed, the team is debriefed, and track logs are either imported from GPS devices or the team leader draws their estimated track on the map. It’s important that all tracks, clues, or information from the assignment be associated with the assignment number. There is a drop-down menu in each attribute table to enter the assignment number. The only exception is the attribute table for the **Assignments** layer, where the assignment number is automatically generated after the first entry.

**Maps**

Map templates are available in many sizes, depending on their intended use: field team maps, tabletop size for planning, briefing maps, and so forth. The sizes range from letter through ANSI E. Each MXD template is sized for the paper and has standard information placeholders, such as incident name as well as date and time of creation, automatically filled in. Grids are displayed in both UTM and latitude-longitude and can be easily turned on or off, depending on the use for the map. Legends can quickly be added to a map as necessary. If you have correctly installed the folder specific to your UTM zone, each MXD is also preconfigured to that zone.
Maps designated with Data Driven Pages (DDP) are used by MapSAR and the Data Driven Pages feature of ArcGIS. Information is used from each assignment record to quickly create an individual map of each assignment. Data Driven Pages allow team maps to be generated with each map centered on a team’s assignment. The map will also print information about the incident, assignment, and search segment and display common information such as scale, datum, north arrow, date, and time produced. Grids are displayed in both UTM and latitude-longitude and can be easily turned on or off, depending on how the map will be used.

Currently, Data Driven Pages maps are available in letter (8.5” x 11”) and ledger (11” x 17”) size templates. These MXD templates can be easily copied and altered for a specific use.

**MapSAR Folder Structure**

**Folder Organization and Naming Conventions**

To maintain consistency and ease of use throughout the Incident Command System (ICS), we’ve adapted the folder structure that wildland fire developed, and then modified it for SAR use. The main goal is to develop a consistent standard throughout the SAR community for easy location and retrieval of files as well as a standardized naming convention. Having a consistent folder structure and naming conventions is vital to make sure information is easily found and identified by other users for after-action reviews. Where applicable, a guide to naming folders and files has been provided. Open the MapSAR folder and double-click the *Incident folder naming.txt* file to see the naming convention for that folder of files to be stored there.
MapSAR Folders

When you open the C:\MapSAR folder, it will look like this:

![MapSAR Folder Structure](image1)

Layer Files Local

You really shouldn’t need any of these packages until you start to modify MapSAR as an advanced GIS user. They’re here for those who’d like to use them, as is the Data Driven Pages code:

![Layer Files Local](image2)

The Tools Folder

These are used during initial setup. These are the add-ins and dynamic-link library (DLL) files that MapSAR uses throughout the product. **Don’t delete or move this folder.**

![The Tools Folder](image3)

MapSAR New Incident Directory Structure

The following describes the core directories that are created when you extract the UTM_xxN_New_Incident.zip file after you’ve created it using the correct UTM zone for your area of responsibility. It will be extracted to C:\MapSAR\UTM_xxN_New_Incident and, for MapSAR to run properly, must not be moved. The UTM_xxN_New_Incident folder, which will be renamed according to the specifics of your SAR, contains the working data model and is where all data created from the SAR should be
stored. It is recommended that you keep everything associated with an incident inside this single folder so it can be easily archived when completed.

Review each folder in the UTM_xxN_New_Incident folder:

- **UTM_xxN_New_Incident**—Rename using the following naming convention: `<yyymmdd_incident_name>` (e.g., 20120509_SearchForBilly), where yyyy = the year the incident started, mm = the month, and dd = the day, plus an underscore and the incident name.

- **Backups**—Use this folder to store and back up copies of the database, map documents, or files. This is very important! You don’t want to lose your work in the event of a computer glitch or human error. It’s a good practice to make sequential backups of the SAR_Default.gdb every few hours during an incident. This also allows you to start over from a known working point should data get badly corrupted.

- **Base_Data**—Base data is not created on the incident. Note that your base data (MED) is not required to be in this location for MapSAR to run properly. Other considerations, such as data duplication or network structure, may cause it to be stored elsewhere due to use during the incident.

- **Dem**—Digital elevation model data and derived products

- **Logos**—Agency logos, typically in nongeospatial raster format such as a JPEG

- **Orthoimagery**—Imagery of the earth that is spatially correct and can be used as a background

- **Other_Maps**—Scanned maps such as visitor or district maps

- **Topo_Maps**—Scanned USGS quad maps, known as digital raster graphics (DRG)

- **Vector**—Vector data file types such as roads and trails.

- **Documents**—This folder stores spreadsheets, text documents, radio logs, digital photos used on maps, and so forth.

- **ICS Docs**—Contains basic ICS templates that can be edited in Microsoft (MS) Word.

- **Incident_Data**—This folder contains data created on the incident stored by date or operational period.
• **GPS**—Contains GPX, shapefiles, and/or text files such as track logs and points, organized by either date or operational period* (A best practice is to create a new folder each day or operational period for each day’s team GPS track logs and waypoints.)

• **Modified_Base_Data**—Base data edited for the incident (i.e., roads, trails, ownership, and structures)

• **Photos**—Photos taken during the incident organized by either date or operational period* and team

• **Map_Templates**—Templates for other map sizes are stored in this folder.

• **Products**—This folder contains GIS product files produced on the incident, such as assignments, briefing, Public Information Officer (PIO), situation, and aviation maps, organized by either date or operational period* and usually in PDF, JPEG, TIFF, or GIF format.

• **Report_Data**—When you create reports, using either the supplied template or one acquired elsewhere, completed reports are stored here.

• **Report_Templates_rlf**—A selection of templates are available for you to use as is or modify to suit your needs. Note that these are RLF files, which identifies them as ArcGIS templates.

• **SAR_Default.gdb**—Don’t rename, open, or mess with this folder. Bad things will happen! Modifying this folder outside of ArcGIS will cause permanent damage to your data.

*For PDFs and other products, an ordered folder structure is recommended. Use a structure that works for your organization, such as naming the folder by date or operational period or a combination of both.

Folder = Operational period number
Folder = yyyyymmdd
Folder = yyyyymmdd + Operational period number
Examples

Folder = OP_01
Folder = 20120112
Folder = 20110112_OP_01

MapSAR.mxd

This is the primary project (MXD) file that you’ll use when starting any incident. It can be renamed to match the name of your incident, for example, <yyyyymmdd_Agency_SARName>, for easier reference.

Figure 1-24
Chapter 2: Tutorial

MapSAR Workflow: Outline for Creating a Search Incident

This is a step-by-step outline of the idealized workflow you’ll want to follow when your first report of an overdue person comes in. The details of each step when using MapSAR are covered in later sections. After training, you’ll probably want to use this outline as a guide and reminder of the general steps to follow, then refer to the later detailed sections as needed.

Not all SARs are going to be alike, of course, so this is an idealized order. You may vary it as information and conditions demand.

1. **Create an incident group.**
   - **Enter information for Reporting Party** (Reporting Party layer). **Optional:** Enter clues and link to the RP using the Attribute Assistant (AA) tool (Clues layers).
   - **Enter incident information.**

2. **Enter date and time of incident** (Reporting Party layer). You can enter safety messages and general objectives later for use in reports.

3. **Add the PLS** by entering an eyewitness verbal description or by entering known coordinates. Fill in fields and associate PLS with incident name (PLS Layers). This will automatically store the UTM (World Geodetic System [WGS 84]) and latitude-longitude in PLS record.

4. **Create multiple operational periods and associate OP with Incident Name** (Operational Periods layers).

5. **Associate Single Record for each OP with IC staff and radio frequency plan** (Operational Periods layers).

6. **Add ICP and staging points** (Incident_Assets layer).
   - **Optional:** Add road blocks, radio relay, and any other assets you will be deploying.

7. **Define the search boundary** (Search_Boundary layer).

8. **Draw, name, and describe segments using the Editor template** (Search Segments layer).
   - **Segment Description text will appear on the assignment map, so include info you want the team to know about the segment, but be concise since size is limited (depending on the paper size).**
9. **Name and build teams** (Teams layer).
   - You don’t need to know what resources are arriving to create team names, so you can pre-create as many teams as you want and populate each Team table with team members’ names once they check in. Teams are assigned to assignments, so if you create the teams early, you can print the assignment maps ahead of time.

10. **Draw assignments using the Editor tools and template.**
    - **Number each assignment and fill out information using the attribute table.**
      Assignment Description text will appear on the assignment map, so include info you want the team to know about the assignment, but be concise since size is limited (depending on the paper size).
    - **Assign the OP to each assignment.** This can be done later if the search order is unknown, but complete it before printing maps.

11. **Print assignment maps using Data Driven Pages.**

12. **Print additional maps** (such as Briefing or Operations).

13. **Populate the Team Members table with check-in information as team members arrive** (Team Members layer).

14. **Once teams are deployed, track team progress on the assignment** (Resource_Team_Status layer).
    - **Add coordinates using either verbal descriptions or x,y coordinates of locations as they are called in.**
    - **Change Status field to indicate team progress.**

15. **As clues are reported, add them using either their verbal descriptions or x,y coordinates and adding clue information.**
    - **Assign relevancy to each clue** (this can be changed later).
    - **Associate each clue with an assignment**, which automatically associates the clue with and fills in the information of that assignment’s team.

16. **As GPS clues are returned from the field, enter GPS waypoint clues using GPX importer.**

17. **As teams return from the field with GPS, download track logs using GPX importer.**

18. **Debrief each team leader and draw routes on the map.**
    - **Associate route with an assignment**—select Hand Draw as entry type to differentiate from a GPS import (Routes layer).
• Complete the assignment after the team leader has been debriefed (debriefing layer).

MapSAR: Beginning a New Incident

Opening the New_Incident Folder
Before starting a new incident, be sure you’ve followed the steps in MapSAR First-Time Setup. You should also have your base data available as described in Creating a Minimum Essential Dataset in the manual Using GIS for Wildland Search and Rescue.

1. To start a new incident, extract and install the New_Incident folder as described in the section Customizing and Opening MapSAR. Rename the New_Incident folder according to the following naming convention: <yyyyymmdd_IncidentName>.

2. After renaming the folder, open the new incident by double-clicking the MapSAR.mxd file. This will start ArcGIS for Desktop. You may also rename MapSAR.mxd to reflect the name of the incident if you want.

3. With MapSAR.mxd open, in the Catalog pane on the right, right-click SAR_Default and choose Properties. Look on the General tab and make sure that the path reads as follows: C:\MapSAR\New_Incident\SAR_Default.gdb. If you don’t see a pane on the right, click the vertical Catalog tab on the right to show the Catalog window.

4. For easier navigation to files, you’ll need to create three new folder connections. At the top of the Catalog pane, click the Connect To Folder button and navigate to C:\MapSAR. Click OK when that folder is highlighted. This will add the MapSAR folder to the Folder Connections. Repeat for the renamed New_Incident folder at C:\MapSAR\New_Incident. Finally, you’ll want to access your Esri-provided data. Click the Connect To Folder button and navigate to C:\ArcGIS\MapData.
Locating Your SAR and Loading Basemaps

1. If you have a high-speed Internet connection and are confident you can maintain that connection throughout the incident, consider using ArcGIS Online as the source of your basemaps.

   A. Select ArcGIS Online from the File menu, and then choose your desired style of basemap. We prefer USA Topo. Use the Search dialog box to locate this map on the ArcGIS Online site.

   B. Select the topo map that has the option Add, not Open. If you choose Open, it will open a new MXD template, which you don’t want.

2. When you install ArcGIS, several useful base data packages are included. They are located at C:\ArcGIS\MapData. You can use these files to quickly locate a city or place and zoom to that area to establish your SAR.

   A. Select the layers you want. C:\ArcGIS\ESRI_Map_Data\usa\USA Thematic Map includes cities, roads, county boundaries, and waterways and is a good choice to have available. Be sure to choose the layer package (with the gold diamond symbol next to it). Drag it into the Base_Data_Group layer in the TOC.
3. Remember, ArcMap draws layers from bottom to top as listed in the TOC when the List by Drawing Order icon is chosen; the Esri layers must be listed above your basemap to make them visible.

4. Be sure the layers you wish to search are checked.

5. Click the Find button (the pair of binoculars) on the toolbar. The standard ArcMap search dialog box will appear.

A. In the Find box, enter a city or town near your incident. You’re doing this to eventually determine what map quads and other data you may need. In this example, sierra madre is used.

B. You can search all visible layers, although this can take longer and may return too many results.
C. As you can see when searching all visible layers, results were returned from USA Populated Places, USA Uninhabited Places, and US Cities.

6. Right-click one of the results and select **Pan To**.

   ![Figure 2-8](image)

   **Figure 2-8**

   A. This centers that point on the screen. Check that this is the correct location and then close the Find dialog box.

7. If you’re using ArcGIS Online, you should now have your basemap visible and the map centered on your selected point.

8. It is recommended that you bookmark this location so you can easily navigate back without the need to use the **Find** function again.

   A. Select **Bookmarks > Create**. Name your bookmark.

9. **If you’re not online, there is** an additional step to add the necessary basemap to the incident.

   A. If you don’t have any local basemaps and you’re not connected to the Internet, see the section *Creating a Minimum Essential Dataset (MED)* in the manual *Using GIS for Wildland Search and Rescue*. You need to have your MED created and ready to use prior to any incident. For this section, assume that you’ve added your MED to the appropriate folders in C:\MapSAR\New_Incident\Base_Data. If you’ve chosen to locate raster and vector data elsewhere, navigate to the appropriate file using your specific folder paths.

   ![Figure 2-9](image)

   ![Figure 2-10](image)
B. From your vector base dataset, select and drag to the basedata layer *CA_USGS_Quad24k* and *CA_Digital_Quad_Reference*.

![Figure 2-11](image)

C. These layers will display a grid, showing which base topo maps you’ll need and which USGS maps the ground teams will want.

![Figure 2-12](image)

D. This layer will display the names of the USGS maps (digital or paper) that will be needed during your incident. Assuming you’ve used the Find tool to center your maps, choose the map quads from the names shown on this Quad index layer.

E. Add the digital topo basemaps and any other layers of data that might prove useful during the incident. Here is an example of the data layers used during a recent incident:

![Figure 2-13](image)

10. **Now, save your work!**

**Entering Incident Information**

The following skills are shown in an idealized order. During an actual SAR, of course, it’s rare to have such a situation. By practicing each of these skills, you’ll be able to quickly use MapSAR to set up an incident in the chaos of a typical SAR. Here
we use the workflow established in MapSAR Workflow: Outline for Creating a Search Incident, found at the beginning of Chapter 2: Tutorial.

Looking at the TOC, you’ll see that information is organized by groups. Beside each group is a plus sign (+), which, when clicked, will expand that group’s individual attributes. Each attribute file stores its information in an attribute table. A table’s attributes are individual fields into which you’ll be entering your SAR’s incident information.

The Incident Group
The Incident_Group consists of the layers that pertain specifically to the incident setup. These layers are where you enter and store information about reporting parties, the incident itself, PLS, and OP. Information in the OP feature class includes the sequentially numbered OPs, the date and length of time for each, a safety message, weather, radio frequencies, and the incident’s command structure.

Some of these layers store data that is not spatial in nature, such as OP; others, such as PLS, have spatial references. A basic understanding of attribute tables makes using these and other layers much easier.

Reporting Party
Here’s an example of the completed reporting party attribute table.

![Reporting Party Attribute Table](image)

Figure 2-15

To enter data into the attribute table, start an edit session:

1. From the MapSAR toolbar, click Editor, then click Start Editing.
If you see a dialog box such as the one in figure 2-17, it’s because you have multiple data sources and ArcMap needs to know which source you want to use to edit—it can only edit within one file path at a time. For all edits involving MapSAR, be sure to select the SAR_Default.gdb (this should be the default) and click OK.

2. With ArcMap in edit mode, you can add data to the Reporting Party Information attribute table.

   A. Right-click the Reporting_Party_Information layer and select Open Attribute Table.
3. Once you see the attribute table, you can enter data in the same manner as you would in Microsoft Excel or a Word table. You don’t need to enter a clue number at this time; this field is for entering additional data from field investigations, such as news from a camper who might have seen the subject. The RP attribute table enables you to gather RP information, tag it as a clue, and have contact information recorded and handy for additional follow-up. Clues will be covered in more detail later.

4. When you’re done entering data, choose Save Edits > Stop Editing from the Editor menu. This will end your editing session.

Note: If you made a mistake entering data and can’t recover, select Stop Editing and don’t save. Also, it may take a few seconds to finish saving; once finished, some fields that you did not enter data in may say <Null>, which is fine.

5. You can now close the Reporting_Party_Information attribute table.

Incident Data
Next, you’ll name the incident and put in a general message.

1. If you’re not already in edit mode, start the editor.

2. Right-click the Incident_Information layer and select Open Attribute Table.
3. Enter the information for this incident.

![Figure 2-21](image)

4. Stop editing and click Yes in response to the prompt: Do you want to save your edits? (Alternatively, Save Edits > Stop Editing.)

![Figure 2-22](image)

5. This next step is very important to the successful operation of MapSAR. It takes the information entered into an attribute table (such as the incident name or OP times) and makes that information available in other relevant attribute tables for the rest of the incident. For instance, if you’ve filled in the attribute table for teams (Team 1, Team 2, etc.), then run the **Attribute Assistant** when you want to create assignments; the team names will appear in a drop-down list to choose from. You won’t have to fill in that information again. Also, the **Update Domains** tool will only run properly outside of an editing session. Before running the tool, always save edits and stop editing.

6. On the MapSAR toolbar, click the **Update Domains** button.

7. A dialog box will appear while the tool runs the **Update Domains** process.
8. If you get error messages or the tool doesn’t complete the process (i.e., the window doesn’t appear), refer to Chapter 5: Troubleshooting. If you don’t see the Update Domains window, check to make sure it isn’t hidden behind the main ArcGIS window. Reinstallation of the Update Domains tool is covered in Troubleshooting.

9. Again, it’s very important that this tool runs, so do not proceed until you’ve resolved any Update Domains issues.

**Entering the PLS**

There are two ways to establish the PLS:

1. Enter an eyewitness verbal description of the PLS location.
2. Enter the actual x,y coordinates of the PLS location.

**Establishing PLS by Eyewitness Verbal Description**

Enter the PLS as if it were a verbal description from an eyewitness, for example: “I last saw Johnny in the Chantry Flats parking lot at 7:45 this morning.”

1. Close any open attribute tables to clear the screen.
2. Click Editor > Start Editing. When you start an edit session, a Create Features window will appear on the right. If you don’t see this window, click Editor > Editing Windows > Create Features. You’ll be using Create Features a great deal, and you’ll need to become very familiar with its functions.
3. Only templates selected with a check box in the TOC window will be displayed in the **Create Features** window. In the TOC, try checking and unchecking the **Assets** layer. You’ll see that the editing templates appear and disappear. This can be very useful to keep your **Create Features** window organized. Just remember, if you don’t see the template, check to see that the layer is selected.

![Figure 2-24](image)

![Figure 2-25](image)

4. Find the **PLS** location on the map and center that spot on the screen: click to select the **Pan tool (hand)** to position the map and the **Scale Window** or **Zoom In** tool to better position the **PLS**.
5. In the **Create Features** window, click once to **Select** the **PLS** icon. As you move your mouse, note that the pointer now looks like the **PLS** symbol.

6. Position the **PLS** symbol over the spot where the overdue person was last seen, and click once. This will place the **PLS** icon at that spot.

7. At the same time, an **attribute table** of **PLS** information will appear.

8. If that doesn’t happen, in the **TOC**, right-click **PLS_Subject_Information** > **Open Attribute Table**.

**Establishing PLS by Coordinate Values**

If you have coordinates of the **PLS**, you can use them to enter that specific location.

1. **Select** the **PLS** icon as above. Rather than clicking on the map with the left mouse button, **right-click** and **select Absolute X, Y**.

Figure 2-26

Figure 2-27

Figure 2-28

Figure 2-29

Figure 2-30
2. Use the drop-down menu in the **Absolute X, Y** box to select the appropriate coordinate system. Type in the actual coordinates and press **Enter**. Repeat for each missing subject.

3. After establishing the PLS location on the map, an attribute table will appear for you to fill in the subject information. You can also fill in that information by opening the attribute table directly: Right-click **PLS_Subject_Information > Attribute Table** in the TOC.

4. Note that for **Incident Name**, a drop-down list contains the incident name you created earlier. This ensures uniformity in data entry and associates the subject with the incident.

5. Create as many PLS entries as required according to the number of missing subjects. As subjects are located, the location of each is established the same way as in **PLS_Subject_Information**, but by using the **Subject_Found** attribute table. The PLS information on each subject carries over into the Subject_Found table, so make sure you enter information about each missing person. **You must use a unique subject number** for each entry.
6. When you placed the point, ArcMap automatically captured the latitude-longitude and UTM zone of the PLS location and added that to the data table.

<table>
<thead>
<tr>
<th>UTM East</th>
<th>UTM North</th>
<th>Latitude</th>
<th>Longitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>404117</td>
<td>3787997</td>
<td>34.228636</td>
<td>-118.041067</td>
</tr>
</tbody>
</table>

Figure 2-35

7. Click **Save Edits > Stop Editing**, and run **Update Domains**.

**Operational Period**

Operational periods have no spatial component, so there is no editing tool in the **Create Features** template.

1. **Start editing** and right-click the **Operational_Periods** layer, then right-click the layer and select **Open Attribute Table**.

There are fields for each aspect of the operational period. It is recommended that you create several periods at this time, as it will make things easier as the search progresses. If you don’t know all the information, that’s okay. The only required field is a number for **Period**, which must be unique. After entering the first value, all other values will be automatically created sequentially by MapSAR.

Although they’re not required fields, much of the information entered in the **Operation_Periods** table will be automatically printed on the customized assignment maps. This includes **Period**, **Safety Message**, **Weather Information**, and **Radio Communications**.

![Figure 2-36](image)

2. When you’re done, click Editor > **Save Edits > Stop Editing**, then run **Update Domains**.

![Figure 2-37](image)
Incident Assets

Adding Incident Assets

Incident assets are a point feature class (that is, a single point vs. a polygon). Here, icons are placed on the map to represent the locations of your assets such as roadblocks, medical station, staging, helibase, and other search resources.

A standard set of asset symbols is displayed in the symbology and is available in the Create Features window when you start an editing session and when the Incident_Assets layer is checked in the TOC.

Add Assets to the Incident:
Click Editor > Start Editing. The Create Features window is displayed on the right.
Assets templates will be displayed if the Incident_Assets layer is checked.

In the same way you established your subject’s PLS, click the asset type you want to add to the map. If you want to establish a point by simply locating it on the map, move an icon over that spot and click once. If you know and want to use the coordinates to establish a point, right-click Absolute X, Y. Choose the coordinate system, type in the coordinates, then press Enter.

Once the asset has been entered on the map, the Attributes dialog box pops up. You can add data about each asset as it’s created. If the pop-up dialog box isn’t displayed, check Troubleshooting for Attribute Assistant, but in the TOC, you can bring up the attribute table by right-clicking Incident_Assets > Open Attribute Table. You’ll also want to do this to edit or review all incident assets.
When you’re done, choose **Editor > Save Edits > Stop Editing**.

### Segments Group

Your basic SAR incident information is now established and entered into ArcGIS and MapSAR: **Reporting Party, Operational Periods, PLS**, and their associated data. Next, you’ll want to draw the areas you need to search. You can do this directly either by entering **assignments** as geographic areas to search or by first creating **segments** and making them **assignments**. In this case, start with the latter method.

#### MapSAR—Creating Search Segments

Please first read the ArcGIS 10 for Desktop Help topic **A quick tour of editing** to understand the selection, editing, and drawing tools used in this section.

The **Create Features** window should appear on the right side of the screen. If not, click **Editor > Editing Windows > Create Features**.

Figure 2-42

![Table showing SAR incident information]

### Figure 2-43

![Create Features window and construction tools]
For this example, use trails to create search segments:

1. **Start editing.**

2. Display your trails layer.

3. Although a trail may appear as a single line, it may actually be made up of a series of connected lines that would not be visible otherwise. In GIS terms, these individual lines are segments that make up the entire line. This is important to know because if you **select** a segment with the **Edit tool**, it may not select the entire segment of the trail you need to create an **assignment**. Review the ArcGIS 10 Resource Center topic **A quick tour of editing** to better understand how to do this.

4. Using the Selection tool, select the trails that need to be assigned to a single segment. Use the **Edit tool** and hold down either **Ctrl** or **Shift** while clicking to select all trail segments.

![Figure 2-44](image)
5. Select **Buffer** from the **Editor** menu. When the Buffer pop-up window appears, make sure that **Not Searched** shows in the template box. In the **Distance** box, enter a buffer distance to indicate how wide you want the segment to be. This might be the distance you can see or how far a voice or whistle will carry. We generally use 25 meters (12 on each side of the trail), though conditions and terrain may change this value. You might also just want to make it wide enough to be visible on either the Team or Briefing map. You’ll need to experiment to find what works best for your needs. Enter the distance and click **OK**. Do not click anywhere else; that would cancel your buffered segment selections.

6. If your trail is composed of several pieces, you’ll need to merge them into a single search segment. In **Editor**, select **Merge**. Highlight the first segment and click **OK**. That will merge all the other segments shown into the highlighted one. If you are only using one segment, the **Merge** choice is unavailable, and you can skip this step.
You’ve now created a buffered polygon the same shape as the trail that will be used as a search segment. Click **Editor > Save Edits**, then continue selecting and buffering more trail segments. When finished, click **Save Edits > Stop Editing > File > Save** to save the whole project as well as your edits.

### Creating Search Segments Using the Scratch Lines Tool

The Scratch Lines tool is used to define drainages and ridges as search segments.

1. **Start editing.**

2. In the **TOC**, click the plus sign (+) to expand **7 GPS_Tracks_And_Routes** and check the check box beside it. Also check the **Scratch Lines** layer check box to make it visible.

   A. In the Create Features window, select the **Scratch_Lines** template and, from **Construction Tools**, choose an appropriate drawing tool.

   B. Draw the search segment; in this case, it has been traced along a drainage channel. If you need to continue drawing off the screen, simply double-click to end the current line, reposition the extent, and draw a second line down the drainage path.
C. Next, use the Edit tool and hold down the Ctrl key to select the line or lines (highlighted blue when selected).

D. Select Buffer; be sure the template is shown as Search_Segments, Not Searched, 0. Buffer the lines as described above. If you drew several lines, merge them to create a single search segment.

E. Remember to save both your edits and your New Incident project as you continue.

Hand Drawing Segments
1. Start editing.

2. Select Search_Segments, Not Searched, 0 from the Create Features pane.
3. Choose an appropriate construction tool. **Note:** If you’ve installed Auto Complete Freehand, the start and endpoints must be complete within a feature. It may be best to draw the first poly area using either the Polygon or Freehand tool. Then, select Auto Complete Freehand for subsequent areas.

4. Continue creating as many segments as necessary, using any or all of the techniques described above.

5. Remember to save your edits as you continue.

**Construct Using Buffer**

This is a tool created specifically for MapSAR. It allows the quick creation of polygons along a line you draw. The tool has a default buffer distance of 12.5 meters to create a total buffer width of 25 meters around the polygon. You can also define this distance. For instance, if you set the buffer tool to 25 meters, it will give you a total width of 50 meters. You may choose to set that distance to make it more visible on a Briefing map or the actual estimated sight distance of your team.

This is an example of a trail that has been buffered by 50 meters.

![Figure 2-54](image1)

**Figure 2-54**

![Figure 2-55](image2)

**Figure 2-55**

1. **Start editing.**

2. Check the **Search_Segments** check box in the **TOC**. This is necessary so the template is displayed in the **Create Features** window.

![Figure 2-56](image3)
A. Select the **Not Searched, 0** template under search segments by clicking it.

![Not Searched, 0 template](image1)

B. Choose an appropriate **construction tool** below. The default construction tool is **Auto Complete Freehand**, which will be selected.

![Construction tools](image2)

C. Change the construction tool by clicking **Construct Using Buffer**.

![Construct Using Buffer](image3)

D. Drag the mouse to start drawing a search segment; choose tracing a road, trail, or drainage path for practice.
E. Click once when you’re finished drawing the segment. The line you just drew will now be buffered by 25 meters, which is the default buffer.

If you need a different-sized buffer width, click once to start drawing, but before you double-click to finish the line, press the D key on your keyboard. A dialog box will appear with the default buffer distance. Change this number and press Enter; click once to finish the buffered line. It will now buffer to the width you set.

Below are examples of simple lines drawn with 25-, 50-, 200-, and 250-meter buffers:
F. Save your edits. Save your **New Incident** project.

### Adding Data to Each Segment

1. Right-click **Search_Segments** and select **Attribute Table**.

   ![Image](image1.png)

   **Figure 2-63**

   A. Give each area a **segment name** and **description** of the area to be searched.

   1. **Segment name**: Usually a letter, for example, A, B, C, AA, AB.

   2. **Segment description** example: “Search trail that loops around Hitchcock Meadow, beginning and ending on Big Stump Grove Road”

   Initially, the **status** for each segment will be **Not Searched**, and the **Searched** value will be 0.

   **Note**: Unless you’re playing catch-up on an SAR that’s already under way and need to capture the trails that have already been covered by the hasty search, change the status to **In Progress**, **Completed**, or **Abandoned**. The **Searched** value should be the number of times the trail has been searched. It’s important to fill in the Searched value; otherwise, it won’t appear on your map.

   **Tip**: To easily identify the segment you’re naming, right-click next to each record and select **Flash** or **Pan To**.

   ![Image](image2.png)

   **Figure 2-64**

   2. Remember to save edits after each segment creation. At the end, click **Save Edits > Stop Editing**.

   3. After you’ve stopped editing, run the **Update Domains** tool. Pause the pointer on the icons on the left side of your toolbar. A tooltip will appear, describing what each tool does. Find the **Update Domains** button, and click it to update the database domains with the search segment names you just created. These will be used throughout the system.
Teams Group

Adding Teams to the Incident

Teams may be added at any time. Entering team names requires that you run the Update Domains tool afterward.

1. Start editing.

2. Right-click Team and open the attribute table.

3. Double-click inside the blank Team Name field to start an entry. That will open a new blank record below the first. Now click just once in the Team Name field and begin entering your information. Enter a unique team name (e.g., Team 1). For Team Type, choose the appropriate type from the drop-down lists. Show the team status as Assigned if you plan to assign them immediately to a search area.
4. **Save edits** and **stop editing**. Now run the **Update Domains** tool to populate the Teams layer database domains.

![Image](figure2-69.png)  
*Figure 2-69*

5. **Save** your project.

**Team Members**

This list helps keep track of searchers in the field and ensures everyone is accounted for throughout the incident.

1. **Click Editor > Start Editing.**

![Image](figure2-70.png)  
*Figure 2-70*

2. Right-click the **Team Members** layer and select **Open Attribute Table**.

![Image](figure2-71.png)  
*Figure 2-71*

3. Complete the field entry for each team member. Every team is on a drop-down list that is derived from the Teams layer.

![Image](figure2-72.png)  
*Figure 2-72*

4. The **Body Weight** and **Gear Weight** fields are used to create a list of all team members and their total flight weights.
5. Click **Stop Editing** > **Save Edits**.

6. Run the **Update Domains** tool.

---

**Assignment Group**

**MapSAR—Creating Search Assignments**

If you haven’t already, read the ArcMap help section *A quick tour of editing* to become familiar with the basic editing functionality of ArcMap.

**Assignments versus Segments**

Often, *search segments* are, in fact, assignments. A team is assigned to search a particular segment—the segment and the assignment are the same. During the creation of MapSAR, it was found that this wasn’t flexible enough. Sometimes an *assignment* is only a portion of a *search segment*, and creating assignments within a search segment better described what a team is expected to do. For this reason, MapSAR makes an exact copy of the segment (or any polygon) chosen and creates an assignment from it. You fill in the assignment information. To reduce map clutter, you can then turn Segments or Assignments on or off, depending on what your needs are.

For instance, a trail segment to be searched hastily would likely be the same shape as a buffered trail segment. A larger segment may have assignments to clear the ridge.

This model allows the flexibility of creating many unique assignments within a logical terrain *search segment*. Remember that, as previously mentioned, if you have absolutely no use for assignments and only want to focus on segments, you should create your segments here in the assignments layer and ignore
the segments layer. This is because if you enter segments but not assignments, certain things in MapSAR won’t work. However, you can enter assignments without entering segments and cause no harm. Using the Buffer tool and the Assignments template, you can then stack assignments using the same geospatial boundaries that you created with your first segment/assignment, should you need to send more teams into that area. Each search of that area becomes unique even though the same area is being searched.

**Creating Assignments**

1. **Start editing.**

2. The Create Features window should appear on the right side of the screen.

3. If not, click Editor > Editing Windows > Create Features.
Using a Segment Shape as a Template for the Assignment
Segment A will be used in the first assignment; it’s actually a buffered trail. For this section, you should have created several buffered search segments along trails as described in the Segments Group section.

1. Using the Edit tool, click to highlight the segment, then select the Buffer tool from the Editor drop-down menu.
2. Select the **Assignment template** and **buffer** to 1 meter distance (the smallest value allowed). This will create an assignment that is 1 meter larger than the segment.

**Drawing an Assignment**

If you’re drawing an assignment, it’s often best to make the **SearchSegments** layer hidden. This is useful so you don’t accidentally select features from segments. Just above the **TOC**, click the **List by Selection** icon, then select the blue icon next to **SearchSegments** to toggle the layer’s availability.
In the Create Features window, select the Assignments template. Its associated tools will now appear in the Construction Tools pane as shown below. Select the appropriate construction tool to draw the assignment. Below is a ridgetop assignment within Search Segment J. This was created using the Freehand tool. Click to draw the line, then double-click when you’re at the point where you started.

A polygon for the assignment will be the result. A pop-up window will appear for you to fill in the assignment information. Either now or later, you would fill in the Operational Period, Team Name, and Assignment Description fields. For the moment, you’re just creating the assignment, not yet assigning a team. If you’ve already created teams and then run the Update Domains tool, the Team Names field will appear in the drop-down list box. Entering assignment information will be covered in the next section.

Continue creating as many segments as necessary using any or all of the techniques described above.

**Construct Using Buffer**

Another tool that quickly creates assignment polygons is the Construct Using Buffer tool.
Select the template first with a single click, then select the **Construct Using Buffer** tool. Draw assignments, and the tool will automatically create a polygon 25 meters wide. To change the buffer width, click to start the drawing, but before finishing, press the D key, enter a width value, press Enter, then click to end the drawing. You may want to create a wider buffer than the default so it shows clearly on team and briefing maps.

You can also use the Scratch Lines feature to create assignments. See the [Creating Search Segments Using the Scratch Lines Tool](#) section.

### Entering Data Associated with the Assignment

Once the assignment shapes have been created, open the attribute table for assignments. If you’re not still in an editing session, **start editing** now.

There are drop-down menus for **Operational Period**, **Team Name**, and **Assignment Status** values. **Assignment Status** options are Abandoned, Assigned, Completed, and Not Assigned. Not Assigned is the default. The other values are pulled from other tables and available after you run the Update Domains tool when filling in other fields, such as Operational Period. This helps keep data entry consistent, quick, and easy.

Note there is also a field named **Printed Map Scale 1:xxxxxx**. This field is used when generating maps for field crews via the Data Driven Pages feature (see [Printing Data Driven Pages](#)). By default, when you select **Center and Maintain Current Scale**, the map is printed with the current scale of the layout view you’ve selected. That doesn’t always work well, as some assignments need a custom scale. For instance, maybe a Helo assignment
needs a custom scale at 1:62,500. In this case, you can enter the necessary scale in the Assignment attribute table specific to that assignment. The map will be generated at 1:62,500 scale.

Data Driven Pages maps are printed at the scale that’s entered into the Scale field. Once a scale is read, Data Driven Pages use that scale until a different scale is read. So, for example, out of 10 assignments, the first 6 can be printed at your default of 24k. Then you can set #7 and #8 at 1:62,500 scale and the last two at 1:24,000 again. The Scale field of the first assignment would read 24000; the first and each subsequent map would print at 1:24,000 scale until there is a change in value, occurring at assignment #7, where Data Driven Pages would read 62500 and generate the next map at that scale. Maps would then be printed at 1:62,500 scale until the next change in value, to 24000. When you change from the layout default and want to return to that scale, you have to make sure you do so within the Assignment attribute table and with the first map you want printed back at that scale.

There is a field named Assignment Description. This text is automatically printed on the assignment map, so when filling in that field, consider what the team needs to know.

Save edits and stop editing.

Important: Next, run the Update Domains Tool. This updates all the related fields throughout MapSAR with the search segment names you just created.

**Printing**

**Printing Data Driven Pages**

Open the Data Driven Pages toolbar by right-clicking on the empty space in the toolbars area and clicking the Data Driven Pages setup button or by clicking the Customize menu > Toolbars > Data Driven Pages.

**Printing with Only a Single Assignment Visible per Page**

1. In the TOC, uncheck the Assignments_DDP layer (it is not selected by default, but make sure) and select (check) the Assignments.
2. Click the **Data Driven Pages** Setup button on the **Data Driven Pages** toolbar.

3. The setup is shown in figure 2-86. On the Definition tab, check **Enable Data Driven Pages**; set **Data Frame** to MapSAR; and change **Layer** to Assignments_DDP, **Name Field** to Assignment #, and **Sort Field** to Assignment #.

4. On the **Extent** tab, select **Center And Maintain Current Scale**.

When you choose **Center And Maintain Current Scale**, remember that you can also specify the scale for each individual map should you want something different from the default set with your layout view. This is set in the Assignment attribute table and in the Printed Map Scale 1:xxxxxx field. See the earlier section **Entering Data Associated with the Assignment** for a fuller explanation of this technique.
5. Click OK to close the Setup Data Driven Pages dialog box.

6. Right-click the Assignments layer in the TOC and select Properties, click the Definition Query tab, and click Page Definition.

Note: You’ll only see this button if the Data Driven Pages feature is turned on.

7. On the Page Definition Query dialog box, select Enable and choose @ # Assignment Number and select Match. (This mirrors the Data Driven Pages setup by Assignment in the Setup Data Driven Pages dialog box.)

8. Click OK, and click OK again.

Switch to layout view by clicking the View icon at the lower left of your data frame or, from the toolbar, go to the View menu > Layout View. Also, turn on the Layout Toolbox. If it’s not already
open, right-click the toolbar. A long menu of available tools will appear; scroll down and choose **Layout**. As with all ArcGIS toolbars, you can drag it onto your main toolbar and anchor it there. Utilize the Layout Pan tool and other Layout Toolbox tools to navigate in layout view.

Using the **Layout Zoom In** tool, magnify the lower right side of the map. Remember that there are two zoom and navigation toolbars: Standard, which moves the map area, and Layout, which maintains the view while you move the map area around. It’s always a good idea to create a **bookmark** when you reach the desired layout in case you accidentally move it or want to try other views.

In the bottom right-hand corner of the map is a text box containing placeholder text. Click the **Select Elements** tool (solid black arrow) and double-click **Map Name Goes Here.PDF**. The name should reflect what the map is, its purpose, and when it was created. The ICS naming convention is `<yyyymmddtime_incident_typeofmap_yyyymmdd_day/nightOP_size_orientation.pdf>`. It seems long, but this will make it straightforward to reprint copies as needed later.

Make any necessary changes to the layout.

To print, select **File > Export Map**. Click the **Pages tab** and choose **ALL Pages** or the individual page numbers you’d like to export. For easy printing of multiple assignments, choose **Export as a Single File**. Select **Type** as **PDF**. Also, choose where the PDF will be saved; there is a PDF folder in your incident folder. See the included text file **Folder_Structure.txt** for suggestions on what file structure to use throughout the incident. Be sure to name the file the same name you typed in the lower right-hand corner in...
the previous step so the digital file name and the name printed on the map match. Name the file and select **Save**.

**Important:** When you’ve finished printing using Data Driven Pages, remember to turn off the Data Driven Pages setup. If you forget, you won’t see all the assignments properly because of the page definition query.

**Printing Other Maps**

Probably the most basic and important skill for the GIS technician to perform during an SAR incident is to generate the maps that plans and operations teams need. Other maps may become necessary for the incident action plan, team briefing, and press releases.

In MapSAR, many standard map templates have been provided that will allow you to quickly produce maps specific to your needs. Map templates are named in a manner to help identify the type of map.

The naming convention used is `<MapSAR_PaperSize_Orientation_Purpose>`.

- Briefing maps are rather plain and contain minimal textual information. These can be used for large team briefings showing the PLS and general overview of the terrain to be covered. Templates are provided in many standard American National Standards Institute (ANSI) sizes.
• Multiframe maps contain two data frames; this allows one frame to be zoomed in to an area of interest, such as the PLS, while the second data frame provides an overview of the search area.

• SitStat maps are best for use in operations. They contain a legend that is easily modified; this provides Operations with the ability to quickly identify features on the map such as clues, tracks, and assignment status.

• Data Driven Pages maps are those intended for field teams. Please see the Data Driven Pages documentation for more information on Data Driven Pages maps.

• Landscape and Portrait maps, obviously, are so named to imply the orientation of the template.

It is recommended that you spend time reviewing all the map templates prior to an SAR incident. When you open a new template, it will contain all your incident data. However, you'll also need to load the map (raster) data being used (see below). Some settings may need to be changed, depending on your printer and print drivers. Printers have different printable areas, so adjusting the templates to ensure that they fit your printer before an SAR is strongly recommended. Modifying map templates in real time is easily done once you understand ArcGIS Layout mode.

This example will cover printing three different styles of maps.

Each MXD file is a copy of MapSAR containing the same layers and pointing to the same data source: SAR_DEFAULT.gdb. As each MXD is a discrete file, you'll need to add basemaps to each template you use.

![Image](image.png)

Figure 2-92

**Basic Template Setup for All Layouts**

This initial setup process is the same for any map template. The entire process will be shown for this first template; thereafter,
just the differences will be shown in the examples of the other templates.

**Tabloid Landscape**

1. From the **Catalog** window on the right, open the **Map_Templates** folder.

2. Double-click **MapSAR_Tabloid_Landscape.mxd**; if prompted to save changes to MapSAR, click **Yes**.

The new template will load in Layout mode. (Please refer to **A quick tour of editing** for an explanation of the Data and Layout modes.)

Note that there is no basemap at this time. You’ll need to load the basemaps that you used previously.
3. Right-click **PLS_Subject_Information** and click **Open Attribute Table**.

4. Right-click the row heading for the subject you want to center on the map and select **Pan To**, which maintains the current map scale (in this case, 1:24,000).

You should now have the data centered on the screen and see all layers of data that have been selected. Close the attribute table.

You can see assignments at this time because the assignment layer is selected in the table of contents.

**Tip:** When you have some downtime during an SAR, load basemaps into as many templates as you feel might be needed during the incident. This will save map generation time when speed is of the essence. Also, play with the basemap transparency to make printed maps readable.

Once your basemap is loaded, you may or may not see the map, depending on the extent of your current screen. In this example, it is assumed that you want to print an area around the PLS, although the same principle shown here applies to any attribute table.
You can also turn off (uncheck) assignments for a clearer picture of the PLS.

Experiment by turning different layers of data on and off to create a map specifically for your needs.

Next, check the printable area of the map based on your printer and print driver:

5. Select **File > Page > Print Setup**.
Verify that your printer is selected and page settings match the template.

Be sure the Show Printer Margins on Layout option is selected. This will ensure that the template will fit within the printer’s printable area. You can only show printer margins when the File > Page and Print Setup > Use Printer Paper Settings option is checked.

6. Click OK.

7. From the Layout toolbar, select the Layout Zoom tool and zoom in to a corner of the map.

   **Important:** If you choose the Standard Zoom tool on the main toolbar, you will change the scale of the map.

   ![](image)

Several vertical lines are displayed; the light gray line is the printable area of the paper. In this example, note that if printed with the current settings, the UTM numbers would be cut in half, so adjust the template slightly to fit the paper.

8. Select the pointer (arrow) from the menu bar.

   ![](image)

9. Click on the map to select it.

10. Now drag the corner so that the text is inside the border.

   ![](image)
Once this corner fits, use the layout zoom tools. Check each corner to ensure that the layout fits the paper. Using the arrow tool, adjust as necessary.

![Figure 2-104](image)

The text at the bottom of the map regarding datum, scale, coordinate systems, and so forth, is dynamic, so it will reflect the current settings on the layout. You may still need to adjust the scale bar to show a conventional distance such as 1 mile instead of 0.8 miles.

Check also that the text fits the paper correctly.

11. Next, you’ll want to change the map title. To do this, click the **Zoom Full Page** icon.

![Figure 2-105](image)

12. Then zoom to the title using the **Zoom** tool.

![Figure 2-106](image)

13. Change the title of the map to reflect the incident and purpose of the map.

![Figure 2-107](image)
14. Click the **About Formatting Text** button to review the various tags available to format the title.

15. Click **OK**.

This next step is recommended to help you keep your printed incident maps organized.

- When someone wants another copy of “that map you printed yesterday,” you’ll be able to easily pull up the PDF and regenerate that exact map.

- PDF files can be offloaded via a shared folder or thumb drive to another machine for printing. This can free up the GIS technician’s time and computer.

- Taking this step provides a history of the search efforts if needed when debriefing at a later date.

- Some printers and plotters print faster from a PDF than directly from ArcMap.

16. Navigate to the bottom right-hand corner of the map using the layout **Pan/Zoom** tools.

There’s a text placeholder: Map Name Goes Here.PDF.

It is recommended that you always print maps to a PDF file and not directly to the printer. This serves several purposes:
17. Double-click the text to display the text entry dialog box.

18. Name the map in accordance with the name you intend to use when saving the document. A best practice is to use the incident command standard naming convention:
<yyyymmddtime INCIDENT_typeofmap_ OP_size_orientation. pdf>.

**Tip:** If you highlight the newly created map name and copy it, you can just paste it in when saving it as a PDF in the next step.

Take a last, careful look at the map. It will print as being what you see is what you get (WYSIWYG). Using the Layout toolbar, zoom to the map’s full extent.

Ensure that the object of interest is centered (PLS, in this case) before printing. Remember also that there’s almost always a need for speed. Don’t get bogged down in creating the perfect map at the expense of slowing down operations. Keep a pen handy for postproduction corrections.

As always, save the map. It would be a shame if a system crash ruined your hard work because you didn’t save it.
19. Now export the map. Remember that you’re creating a PDF, not printing. From the File menu, select Export Map.

The Export dialog box will appear; here’s where you will name the map as you typed it earlier. Practice using the ICS naming convention by naming it 201202011230_EricSAR_Briefing_OP3_8X11_Landscape.pdf.
20. Navigate to the PDFs folder and select an appropriate location to store the map.

21. Name the map, but don’t click Save yet.

Depending on your printer, setting the **print quality** to Draft may produce cleaner topographic lines than Best. Ink-jet printers will do one pass for Draft, two for Normal, and three for Best. One pass of the print heads usually works well for topo maps.

Also, depending on the desired quality of your basemap, you may want to set the dpi to match. There’s no need to print a 150-dpi basemap at 300 dpi. Doing so just makes the PDF file larger and takes more time for the printer to process.

22. When you have completed the settings, click **Save** to create the PDF file.

Check the folder and open the new PDF to make sure the file was successfully created.

The completed PDF map is shown below:
23. **Save** your map.

To return to MapSAR, double-click **MapSAR** in the Catalog window.

---

**Mutiframe Documents: Additional Steps**

1. Open **MapSAR_ANSI_C_17x22_Briefing_MultiFrame.mxd**.

   ![Figure 2-117](image)
   
   **Figure 2-117**

   2. To start with, you have two data frames in one template, as the file name suggests. Each data frame is independent, so you’ll need to add a basemap to each frame as well as center your point of interest.

   ![Catalog window](image)
   
   **Figure 2-118**

   ![Figure 2-119](image)
   
   **Figure 2-119**
In this example, the basemap has been added to both data frames.

![Map with basemap](image1)

**Figure 2-120**

3. Next, use **Pan To** from the attribute table to center the PLS in each frame individually.

As each frame is independent, you can set the scale in each frame separately. This example is zoomed in to the PLS location at a scale of 1:5,000. The larger frame is set to 1:24,000. This might be useful during briefings as it allows the big picture to be understood while showing a detailed view of the PLS.

![Attribute Table](image2)

**Figure 2-121**

To make changes to a data frame, it must be the active frame, which is displayed in bold in the TOC.

4. To activate a data frame, right-click and select **Activate**. You can also use the pointer tool and click **Insert** to toggle it.
Once a frame is **active**, make any changes necessary to that frame, for instance, choose visible layers or determine scale and map position.

*Always save before creating the PDF or printing.*

*Working with multiple data frames can be a little confusing at first. Just remember to activate the frame you’re working with and that each frame is completely separate from other frames.*

---

**SitStat Maps (Situation Status)**

1. Open `MapSAR_ANSI_D_SitStat.mxd`.

You’ll first need to add a basemap and center your point of interest, as described above. Again, use the PLS as the point of interest.

The SitStat maps have a legend that automatically updates according to the layers that are displayed. Please refer to the ArcGIS Resource Center topics for more detailed information on the legend.
Using the layout Pan and Zoom tools, here’s a close-up view of the legend. Just the PLS, Clues, and Team Assignment layers are being displayed.

2. To change the legend display, use the pointer and double-click the legend.

This opens the Legend Properties dialog box.

On the left side, all available layers are listed. On the right side are layers currently being displayed in the legend.

Use the tabs to review the available options.
**Note:** Only layers with spatial information are applicable to the legend. Layers such as teams or operational period contain no spatial data.

3. Add **Resource_Team_Status** to the legend as an example.

4. Click the **Items** tab.

5. On the left side, select **Resource_Team_Status** and click the right arrow button to add it to Legend Items.

6. To show the number of options available, double-click **Resource_Team_Status** to display the Legend Item Selector dialog box. Here you can choose from a variety of styles:
7. For even more options, select Properties. You’ll see that you have a great deal of control over how items are displayed in the legend.

8. Click OK to accept these settings.

The Map Connection options are also worth exploring.

Selecting the Place in new column option can be useful when the legend has a lot of items to display.

9. Once you have selected the legend options, click OK. You can move the legend around the map to the best location by using the pointer; click the legend once to select it and then drag it around the map. Find a location that does not interfere with the information you want to show.
10. **Save** your map before **exporting** it to PDF.

### GPS Tracks and Routes

**Importing GPX Files (Waypoints, Tracks, Routes)**

ArcMap and MapSAR don’t support a direct connection to a GPS device for downloading tracks, routes, or waypoints. You will first need to download the data from the GPS device using a third-party program. Your GPS device likely came with software to do this. Garmin GPS devices, for instance, come with Garmin Basecamp. This program is also available free of charge from www.garmin.com. MapSAR works with GPS files in GPX format. This is an important consideration in purchasing a GPS. Some use a proprietary format, though all can be converted to GPX using the utility software provided. For more information on considerations in purchasing a GPS, as well as instructions on creating a GPX file for export, see the section Using Your GPS for SAR in *Using GIS for Wildland Search and Rescue*.

As an SAR gets busy and the demands on the GIS technician for mapping products increase, you will definitely want to consider having a person dedicated to downloading GPS data as teams come in. Advantages include the following:

- You won’t need multiple copies of ArcMap open on different computers.
- You won’t tie up your GIS technician to simply download GPS units. A GPS program such as Basecamp is easy enough for anyone to use.
- You can set up several computers and save GPX files to a shared folder, then dump all GPX files into it for quick import later into MapSAR.

When downloading team member’s GPS data, it is important to adopt a naming convention that identifies where that file came from and what’s in it so it’s immediately apparent to anyone needing to recheck that specific information. Again, this example uses a slightly modified ICS naming convention for standardization: `<yyyyymmdd_type_TeamMember_trk or wpt.gpx>`. A reminder file, GPS file naming.txt, is included in the /
GPS_In folder where GPS files are stored for MapSAR. You should also consider creating subfolders by operational period to organize the data (e.g., OP1, OP2).

If the globe-shaped icon for the GPX converter is not already installed on your toolbar, you can install it by selecting the Customize menu > Customize Mode > Commands > Add-In Controls. Drag the GPX Import icon onto the toolbar. Placing it fourth from the left will make it consistent with all MapSAR documentation. Click Close.

![Figure 2-131](image1)

**Importing Tracks or Waypoints**

**Important:** There are two layers that are not visible (unchecked). They are used just for the GPX import process. This is necessary, as the other Routes and Clues layers have several joins, which makes appending to the feature class difficult. These layers must be in the TOC, so don’t remove them.

![Figure 2-132](image2)
After you have downloaded your GPS files and converted them to GPX format (if necessary), copy and paste them into C:\MapSAR\New_Incident1\Incident_data\GPS_In.

Next, click the **GPX Importer** button.

Navigate to the folder containing the GPX files.

Either select a file and click OK or double-click any file. By only selecting one file, the GPX importer will process through each file in the folder, appending the GPX data to the selected feature class. Once a GPX file has already been imported, it won’t be imported again. That way, you can continue to add GPX files to a single folder and they won’t be processed a second time.
Next, select the type of data to be imported: **Waypoints** (clues or important geospatial points the team noted) or **Tracks** (aka track logs). Routes are not supported in MapSAR at this time.

It’s important to select from the drop-down list: either **GPX_Track_Import** or **GPX_Clue_Import** layers only.

Click **Add**.

After a very short wait—about one second—you’ll see a dialog box confirming that the import has succeeded.

Once imported, open the attributes table for either **Routes** or **Clues**.

Figure 2-136

![Add GPS Data](image1.png)

Figure 2-137

![GPX Successful](image2.png)
Routes are shown below:

**Table 2-1:** The following data is imported with the GPX file:

<table>
<thead>
<tr>
<th>Name</th>
<th>Prefaced with Track, Route, or Waypoint, depending on data type (If the GPX file has been saved with a name, it’s displayed; if not, the import date is used.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Date the track, waypoint, or route was saved</td>
</tr>
<tr>
<td>Source</td>
<td>GPS: Always shown as the source.</td>
</tr>
<tr>
<td>File Name</td>
<td>Name of the GPX file in the file system</td>
</tr>
<tr>
<td>File Location</td>
<td>Where the GPX file was pulled from in the file system</td>
</tr>
</tbody>
</table>

Once imported, select an assignment from the drop-down record to identify its origin (remember, assignments are the unique identifier throughout the system).

Selecting an assignment number automatically fills in the team, period, assignment description, and status information associated with that assignment.

**Drawing Routes**

Routes in this context are line representations of where a team has been—they’re not necessarily GPS tracks. Routes can be imported from GPS track logs or drawn by hand. In this example, a team leader is being debriefed; the process remains the same regardless of the reason to hand draw the route.

A route can be drawn while a team is being debriefed. The GIS technician (you or another person assigned with a computer) asks the team leader to draw on the screen the route the team is believed to have searched.

1. **Start editing.**

2. Select **GPS_Tracks_And_Routes** from the table of contents.

   ![Figure 2-138](image)

   In the editor templates window, you’ll see a set of templates for routes.

   Different routes have been color coded for easier on-screen recognition.

3. For this example, select the **Hand Drawn** template by clicking it.

   ![Figure 2-139](image)
This enables the template to be freely drawn on-screen. The default construction tool is **Freehand**, but you can select another construction tool by clicking it.

4. Use the **Pan**, **Zoom**, and **Scale** tools to locate the area of interest.

5. Draw directly on the screen to denote the path of travel. Review the section Using Scratch Lines for tips on having team members do this.

6. Next, open the attribute table for the Routes layer by right-clicking **Routes**.
7. The attribute table will appear. Associate an assignment number with the route and complete data entry in the other fields.

8. Stop the editing session and save your changes.

**MapSAR—Reports**

A report provides an effective way to display attribute information in a format that you control.

Included in the MapSAR core product are several basic report layout files (RLF). These are located in the `Report_Templates_rlf` folder. You are encouraged to modify these layout files to suit your needs. In addition to saving your layout files in MapSAR, be sure to save them outside of MapSAR so you have them when you start a new incident. See [Creating a report](#) in ArcGIS Resource Center for additional information about creating report layout files.

1. To print a report, click **View > Reports > Load Report**.

2. Browse to the `Report_Templates_rlf` folder and select the report layout file you want to use for this report. Click **Open**.
3. You can make layout changes, add graphics or fields, and so on. Please see the ArcGIS Resource Center documentation Creating a report. After making changes, save the template by clicking the disk icon. Be sure to save templates as RLF files.

4. To run the report, click the green Play button.

The report will be displayed on-screen.
5. To print the report, click the Export Report To File button. In the Export Format box, select Portable Document Format (PDF).

6. Browse to the PDF folder, give this report a name, and click Save.

The report can be printed anytime by opening and printing the PDF file.

**Subject Found**

1. Start editing.
2. From the Editor menu, select Options.

3. Select Attributes display and check the Subject_Found layer. Click OK.

4. Ensure that Subject_Found is checked so the template will be shown on the right-hand window.

5. If the subject’s location was given to you in coordinates, select the Found template in the Create Features window.

6. Then right-click anywhere on the basemap and select Absolute X,Y.

7. Select the appropriate coordinate system.
8. **Enter** the coordinates of the subject’s position and press **Enter**. Remember that $X$ is the longitude, or easting value, and $Y$ is the latitude, or northing value (in North America).

Because you checked the **Subject Found** box in **Attribute Assistant**, that attribute dialog box will be displayed as a pop-up window.

9. Complete the information and click **OK**.
10. Because multiple subjects can be listed in MapSAR, be sure to enter a **Found** location for each subject who has been located.

11. Now place the subject symbol on the map; a label will be displayed with information on the location and description.

![Figure 2-156](image)

12. If only a verbal geographic description of the Subject Found location is given, enter the position by first **selecting** the **Found** template.

13. Then find the location on the basemap according to the description given (e.g., “north shore of Charlotte Lake”). Use the **Pan** and **Zoom** tools to move the map as necessary.

14. Move the **Found** icon over the map and click the appropriate location. Complete the attribute dialog box and click **OK** to close it.

15. **Save edits. Stop editing. Save** your incident.

16. **Run UpdateDomains** to propagate the new information throughout the incident database.
Chapter 3: Additional MapSAR Features

Creating a Search Boundary

There are several methods used to create a search boundary. Which method you choose will depend on the incident and how the incident commander wants to define the boundary. Several methods follow, from basic linear distance to complex polygon shapes.

The examples below will use PLS as the initial planning point, although you can potentially select any location as the IPP.

Start with the simplest boundary to create, using a polygon shape.

From the Editor menu, click Start Editing.

Make sure that **13 Incident_Analysis** and **Search_Boundary** are both selected (checked).

You should see the Create Features editor window on the right and the **Search_Boundary** template.

If your IPP isn’t centered on your map, make it so. Center the PLS here. Right-click the PLS_Subject_Information layer and select Open Attribute Table.

Right-click the **Subject** line and select **Pan To**.
Panning will maintain your current map scale and center the point on-screen. **Zoom To** will change the current scale.

The **PLS**, which will be the **IPP** in this example, is now centered on the map.

Adjust the map scale so you can see all the area that will define the search boundary. For this example, select 1:100,000.

**Tip:** You aren’t bound to the default displayed scales. If you type a value into the Scale box and press Enter, the map will be drawn in the scale you have entered.

The first example will be to draw a circle around the IPP.

Select the **Search_Boundary** template, then select the **Circle** tool from the **Construction Tools** list.

Click once at the point that will be the center of your circle and drag the mouse outward to start drawing the circle. If the edge of the circle is to be visually established, keep dragging until the desired size is created, then double-click when finished. If you
mess up, simply complete the circle, then press the Delete key on your keyboard to delete the circle. Then try again.

**Tip:** If you really mess up while in an editing session, stop editing and don’t save changes. This will return the database to its previously saved condition. Of course, you will lose any changes that you made in that editing session since your last editing save, including the ones you may want. So when you’re satisfied with an edit, it’s always a good idea to save it right away.

If you have a defined radius for the boundary you want to draw, you can use that to create the circle. Click once to place the center of the circle as you did above. Next, right-click and select **Radius**.

![Figure 3-9](image)

Enter the radius (in this case, in meters).

![Figure 3-10](image)

Press **Enter** to draw your circle. (Above, a small circle has been drawn for display purposes.)

You aren’t limited to a circle in this method; you can use the other construction tools to create boxes.

Try the same exercise, but this time, select the **Rectangle** tool.

![Figure 3-9](image)
When you start to draw, a point appears at a corner. From there, draw the first leg of the rectangle. The purpose of this tool is to be able to draw using 90-degree corners on all sides.

Right-clicking gives you additional options:

Once you have the length of the first leg, click once to place that corner. Now drag the rectangle to the desired size.
Alternatively, right-click for additional placement options.

Another construction tool to try is Auto Complete Polygon.

The Auto Complete Polygon tool gives you more control of the boundary shape. The key to using this tool is to overlap the ends of the polygon to complete the drawing.

Repeat the exercise, but this time, select the Auto Complete Polygon tool from the Construction Tools list.

Click once at the starting point of the polygon, drag to draw a line, click the next fixed point, and continue clicking and dragging to complete the boundary.

Be sure to cross the ends before double-clicking, or the polygon will not be drawn.
Try the other tools such as **Freehand**. They all work in a similar manner.

Another way of creating a circular search boundary is by using the **Euclidean Buffer tool**. This will create concentric circles as a search boundary. For instructions on the Euclidean Buffer tool, see [PLS Euclidean Buffer](#) in Chapter 4 of this manual.

Below is an example of a Euclidean buffer with 1-, 3-, 5-, and 7-mile rings:

You can use any of these techniques alone or in combination to create your search boundary.

Once you have created the boundary, you can add comments in the attribute table for a label and a description. Right-click the **Search_Boundary** layer and select **Open Attribute Table**.
Using Scratch Lines

Scratch lines can be used for several operations, such as drawing search segments, having a team leader draw a searched path while being debriefed, or quickly highlighting areas of interest.

1. **Start editing**.

2. Select **Scratch Lines** in the **Create Features** template.

3. Select the construction tool that best meets your needs. The default is **Freehand**.

4. Start the drawing with a single click, draw, and end with a single click. If you need to delete lines, simply select by using the Selection tool and press Delete on the keyboard.

5. Any scratch line can be easily buffered and added to a feature class.

Below is an example:

A. When being debriefed, the team leader will draw a best estimate of the route the team traveled and searched.

B. **Start Editing** > click **Scratch Lines** > select **Freehand** construction tool.

C. Have the team leader draw the route on the screen, clicking once to end each line. Expect to have to delete a couple of attempts. You can also have a test MapSAR project open to practice on first.
D. After the team leader has been debriefed, you’ll add the hand-drawn paths to the Routes layer.

**Adding Hand-Drawn Scratch Lines to the Routes Layer**

Select any lines drawn by the team leader by using the Selection tool.

Select the Buffer tool from the Editor menu.

Select the Routes template.

Set the buffer to 1 meter and click OK.

If multiple lines were drawn, they must be merged. Do not click anything yet. Doing so would cancel the selection of the newly created route line.

Select the Merge tool from the Editor menu. This will merge all selected features into a single record. If Merge is unavailable, the features are already in a single record and you can skip this step. Click OK to merge.
Right-click the **Routes** layer and select **Open Attribute Table**. Select the appropriate assignment number for that team. The Team Name and Team Type fields will be automatically populated.

Once you’ve saved the information in **Routes**, you can open the attribute table for scratch lines and delete all records, as they will no longer be needed and would clutter up the map, getting in the way of debriefing team leader and selecting lines.

**Radio Log**

This layer is included more as a place to store historical data than to be used in real time. If you’re running ArcGIS for Server or a second interface using Flex, consider using the radio log. Other than that, it’s a burden for the GIS technician to keep updating radio traffic during an incident.

The radio log is an attribute table without any spatial information. Enter data as follows:

**Start editing.**
Right-click the **10 Radio_Log** layer and select **Open Attribute Table**.

![Figure 3-28](image)

Begin entering information.

![Figure 3-29](image)

As always, remember to save often by selecting **Save Edits** from the **Editor** menu.

![Figure 3-30](image)
Chapter 4: Advanced Skills

Georeferencing Aerial/Satellite Photographs
MapSAR enables you to take any image that represents real terrain and place it on the map. The process is called georeferencing. For instance, you can scan a park’s brochure map and then, using the instructions here, line it up with your existing digital map. This can be useful because it might be the map your lost people have, and you would want to be able to integrate it into the map set you’re using. This allows you to imagine how they might have seen the terrain and determine possible places to go for help, and you can add clues or any other SAR information.

ArcGIS allows you to georeference a map—a JPEG or PDF, for instance—that does not originally have the digital coordinate information. Using the Georeferencing tools, you can properly size it and orient the JPEG map image so that it aligns with the basemap that you’re using. You need to remember, though, that the results will likely not be precise, although they can be very useful for planning and illustration purposes.

Obtain an Image to Georeference
The first step is to obtain a JPEG of the area of interest. If you plan to zoom in close, a high-resolution JPEG will be needed. If you’re just using the JPEG to get a qualitative view of the area (for instance, to identify areas where a helicopter would be an effective search tool), then the resolution is less important. You can also obtain a brochure map for your local area and scan it. This example will use a low-resolution photo obtained from ArcGIS Online.

1. Go to ArcGIS.com and locate the area of interest by clicking the Map tab and changing the basemap to imagery. Make sure the image has at least three identifiable point features that you can associate with features on the map (e.g., road intersections, a switchback on a trail, a defined peak).

2. Do a screen capture by pressing Ctrl+Print Screen. Then start a program, such as Paint or PowerPoint, and paste that image into the program. Save the file as a JPEG in the C:\MapSAR\New_Incident\Photos folder. It is suggested that you use the Photos folder within the incident to keep your data organized. In keeping with the recommended naming convention,
rename the new incident folder 20111118_SMSR_Billy. The title of the photo used in this example is Chantry_Aerial_Photo.jpg.

Add the Georeferencing Toolbar
On the main menu, click Customize, then Toolbars, then Georeferencing.

If the toolbar is floating on the MapSAR data frame, you can dock it by clicking on the dark area at the top of the toolbar and dragging it up to the top of the screen, just below the MapSAR toolbar.
Add the Photo to MapSAR

Click the **Add Data** icon at the far left end of the MapSAR toolbar.

Navigate to the C:\MapSAR\YourIncident\Photos folder, select the JPEG file, and click **Add**. If you double-click the JPEG, it will drill down to a layer where the individual color bands are stored. You don’t want to be there. Go back up one level, select the JPEG of interest, and click **Add**. At this point, you might see an error message that says ArcMap can add the photo but doesn’t know where to put it.

For now, click **OK**. In the **TOC**, you should see a new layer added just above the Basemap layer.
Georeferencing

In ArcMap, pan to the approximate area you want to superimpose the JPEG. Then, on the Georeferencing toolbar, click the drop-down arrow and click Fit To Display.

To facilitate matching locations in the photo with locations in the basemap, it’s convenient to make the JPEG partially transparent. To do this, go to the Table Of Contents window, right-click the Chantry_Aerial_Photo.jpg layer, then click Properties at the bottom of the menu. Click the Display tab, then set the transparency to something that enables you to see both the JPEG and the underlying basemap reasonably clearly (e.g., 44%). Click OK. You should now have a semitransparent JPEG overlay above your basemap.

Resize the JPEG. On the Georeferencing toolbar, click the Layer drop-down arrow. Make sure the correct JPEG file is selected.

To resize and reshape the JPEG, ArcMap needs at least three control points on the JPEG that can be aligned with the same three control points on the basemap. You’ll get better results if you have more control points and points that are spread over the entire image.
On the **Georeferencing** toolbar, click the **Add Control Points** button.

![Image](image.png)

Figure 4-9.

Click a control point in the JPEG, then click the corresponding location on the basemap.

**Very important:** Click the JPEG control point *first*. After clicking the next point, you’ll see the JPEG shift its location so the two points align with each other. Click a second control point on the JPEG, then click a second control point on the basemap. Your JPEG is now reduced/enlarged to the correct scale (but only in one dimension) and has probably rotated a bit. Pick a third control point and repeat.

Look for landmarks or intersections so you can be sure you are lining things up correctly. It’s also best to start with control points at the edge of a JPEG and work inward. This helps size and orient the map more accurately. For better visibility and to increase accuracy, you can also place graphic control points (use an X) on the map. This allows you to see better and add matching control points.

After selecting the third point, you may get a warning message saying that your points are poorly distributed.

![Image](image.png)

Figure 4-10

Ideally, your control points should be well spread out on the JPEG, not in a straight line. Three points in a line will generate the warning. To remedy this, add a fourth point that’s well off the line.

To facilitate matching up the control points, you can click the box next to Chantry_Aerial_Photo.jpg in the table of contents to turn the JPEG layer on and off. You can also adjust the transparency as described earlier.
Assess Accuracy of Fit
After setting up several control points, the JPEG and the basemap features should align pretty well. To see how well they line up, click the View Link Table icon at the far right of the Georeferencing toolbar.

You should see something like this:

The numbers in the Residual column at the far right show how far off that point is from the best-fit transmogrification of the JPEG. In the table above, the last point (row 6) needs adjusting. If you click the row, the corresponding control points on the map will turn from blue to yellow.

Undo Bad Points or Errors
To delete that point and do it over, click row 6 to highlight the entire row, then press the Delete key. Now you can click the Add Control Points button to redo that point or add different points.

Make Changes Permanent
On the Georeferencing drop-down menu, click Update Georeferencing. This will save the transformation data and remove it from the Link Table. You can add new control points to the Link Table, but you can no longer modify the ones you just saved.

Undo Transparency
Right-click Chantry_Aerial_Photo.jpg in the TOC. Click Properties > Display tab and reset the Transparency value to 0. Click OK. To make the JPEG visible/invisible, simply turn it on/off by checking/unchecking the box next to Chantry_Aerial_Photo.jpg in the TOC. Now you can draw a search area for the helicopter using the georeferenced photo.
Adding a Photo to Your Clue Attribute

Note: This feature is available only with an ArcGIS for Desktop Advanced license but is being documented here for its usefulness.

If a photo is to be associated with the clue, select the Attributes button from the Editor toolbar and choose Open Attachment Manager.

Link an attachment to a clue:

Browse for the photo and click Add.

Select the picture and click OK.

The picture can now always be viewed either by selecting Attributes when in edit mode or by using the Identify tool.
**PLS_Euclidean_Buffer**

Open **SAR_Toolbox**.

Right-click **PLS_Euclidean_Distance**, then **copy and paste** to create a duplicate.

Rename the resultant model **PLS_Euclidean_Distance KM**.

Right-click **PLS_Euclidean_Distance KM** and select **Edit**.

When the model opens, right-click **Multiple Ring Buffer for Hiker Category** and choose **Open**.
Change **Buffer Unit** to Miles.

**Maintaining a Radio Log Using an MS Excel or MS Word File**

Radio logs are often best kept in a simple format such as an Excel spreadsheet or Word document. If you’ll be importing those logs into MapSAR at the conclusion of the search for historical reference, you’ll want to include the fields in the MapSAR feature class.

The radio log in MapSAR contains the following fields:

![Figure 4-20](image)

**Close** and **save** the model.
Create an Excel spreadsheet with the same fields.

![Excel spreadsheet](image)

Figure 4-21

You can also do the same in an MS Word document:

![MS Word document](image)

Figure 4-22

Have your dispatcher use this log throughout the incident.
Chapter 5: Troubleshooting

These are some of the known problems users have had. This section will be continually updated in the online PDF version of this manual at MapSAR.net.

**Versions**

How do I know which version of MapSAR I’m running?
MapSAR will be updated occasionally as new tools are developed and errors are discovered. The latest version will be at MapSAR.net

Open MapSAR.

Change to content view.

![Figure 5-1](image-url)
Locate the **Version** table, then right-click and select **Open**.

![Image of a computer interface showing a table with columns for MapSAR Version, Update Date, Updated By, and Desc. The row shows v1.3, 1/11/2011, Jon Pedder, and Release version 1.3.](image)

**Figure 5-3**

The version you’re running is identified:

I’m getting a strange error after upgrading my version of MapSAR (I had a previous installation).

You’re likely getting an error from an old version of **Attribute Assistant**. This tool (per Chapter 2—[MapSAR Workflow: Outline for Creating a Search Incident](#)) is widely used throughout MapSAR, and as features are added, the version will need updating. This can happen when you install a new version of MapSAR but the older version of **Attribute Assistant** doesn’t update with the new installation.

*First, remove the current installation of Attribute Assistant.*

Select the **Customize** menu and then **Add-In Manager**.

![Image of a computer interface showing the Customize menu with Add-In Manager highlighted.](image)

**Figure 5-4**
Next, select **Attribute Assistant** and click **Delete this Add-In**.

![Add-In Manager](image)

**Figure 5-5**

Close this window and exit MapSAR.

Once closed, verify that the ArcMap process closed completely by checking it in Windows **Task Manager**:

Right-click the task pane and select **Start Task Manager**.

If ArcMap (**ArcMap.exe**) is running, select it and end that process.

![Task Manager](image)

**Figure 5-6**

Close this window.
Install the latest version of Attribute Assistant.

Locate the BAT file appropriate for your OS (Windows 7 or Windows XP) in the C:\MapSAR\Tools folder.

If you’re using **Windows 7**, be sure to right-click and **Run as administrator**; otherwise, the files will not be installed correctly.

The installation process is automatic. When prompted, select **Install Add-In** or click **OK**, as appropriate.

If you get an error message, make sure you’re running in **Administrator** mode and that you have the MapSAR folder installed at the root of your C: drive.

Once installed, verify the installation by checking the **Customize > Add-In Manager > Add-Ins** menu in MapSAR to see that the new version of **Attribute Assistant** was successfully installed.

**Editing**

I’ve started an editing session and don’t see what I expected to. Click **Editor > Start Editing.**
I don’t see the Create Features editing templates window.

You see either the Catalog window on the right or no window at all.

Click **Editor > Editing Windows > Create Features.**

This will display the editing templates window and all selected layer templates.

![Figure 5-13](image1)

![Figure 5-14](image2)

![Figure 5-15](image3)
I don’t see the template I’m looking for.

Templates will only be displayed if the associated layer is selected as visible. See the Table Of Contents window (left side) and verify that the layer is selected as visible.

In the example here, note that the Assignments layer is checked; however, the 3 Assignments_Group layer isn’t. Because Assignments is nested within a lower level of 3 Assignments_Group, it won’t be visible until it is also checked. Once that happens, it will be available as an editing template in the Create Features window.

Check 3 Assignments_Group to activate the already-checked Assignments layer:

Even if the layer to be edited is checked, the appropriate Create Features template might have disappeared. This can happen if it’s been accidentally deleted or perhaps due to an unknown glitch. Fix this by starting an editing session: from the Create Features window, choose Organize Template > New; then choose the template type that’s disappeared. The re-created Create Features template will now be listed in the pane.
I don't see the Table Of Contents or Catalog window.

Use these buttons to display the TOC window showing your data layers:

I know I have many assignments, but when I open the attribute table, they're all missing.

This can be caused by several things. First, make sure you've checked the Assignments layer in the TOC.

Most commonly, this issue starts after printing using Data Driven Pages. When using Data Driven Pages, one assignment at a time is displayed and sent to the printer. If the Data Driven Pages feature is still active, you'll only see one assignment listed in the attribute table. Don't be alarmed if the Assignments attribute table displays “0 out of 1 Selected.”
To see all your assignments again, turn off Data Driven Pages:

Click the Data Driven Pages Setup button.

Verify that Enable Data Driven Pages is checked.

Uncheck it to turn off Data Driven Pages.

All your assignments will be listed in the attribute table.

One other possible reason is that you've applied a query definition to the Assignments layer.
To resolve this, select **Assignments**; right-click, and then select **Properties**.

![Figure 5-28]

Click the **Definition Query** tab.

![Figure 5-29]

Clear the query by **highlighting** and **deleting** it.

![Figure 5-30]
Labels on map features are too large (or too small).

Depending on the map scale you’re working in, the labels of features (for instance, PLS, Assignment) can be too large and make it difficult to see what you need. If you don’t need the labels while working, you can always turn them off temporarily. In the TOC, simply right-click the feature class and uncheck Label Features. Be sure to turn them back on when you begin producing print maps or for briefing sessions.

You can also change the labels to a different map scale or to none. Position the mouse pointer over the center map section, right-click and choose Data Frame Properties. On the General tab, choose Reference Scale and then either the scale you’re working in or None. Click Apply to see which gives you the best work area for your needs. When printing a map, make sure Reference Scale is set to the scale you’re printing at or one that makes the labels easily visible. For example, if you’re creating a briefing map, make sure the labels can be read from across a room. Always make sure your maps fit the audience and situation. An important part of preparation for an SAR GIS technician is, prior to any active operation, to practice with various map sizes, colors, and label sizes to make sure they’re visible and understandable in whatever situation they’re being presented.

Problems Running Update Domains

I receive an error message when running Update Domains. The first thing to do is actually read the error message. It’s a little cryptic, but it often explains what the problem is.

The most common issues are as follows:

Schema Lock

You’re still in an edit session, and the tool can’t get exclusive access to the database. The error reads “Cannot get exclusive schema lock.”

You need to stop editing, then rerun the Update Domains tool.
A schema lock error can also occur when multiple ArcMap processes are running, holding the database open and denying exclusive access to a database. This can happen when you’ve been opening and closing ArcMap but the operating system hasn’t ended the process correctly.

If you’re sure editing is stopped and you’re still receiving a “Cannot get exclusive schema lock” error message, try the following before restarting your computer.

First, save your document. Then open Task Manager in your operating system. Windows 7 will be used in this example.

Right-click the application bar and select Start Task Manager.

Look to see if multiple processes of ArcMap are running. If so, exit MapSAR.
Next, select each ArcMap.exe process and click **End process**.

Once all ArcMap processes have ended, reopen MapSAR and rerun **Update Domains**.

**Duplicate Values**

Another common cause of **Update Domains** errors is having duplicate values in the attribute tables. MapSAR pulls values from several attribute tables and writes them to domains in the database. Domains cannot contain duplicate values; therefore, if you have duplicate values, **Update Domains** will generate an error message.

The following tables and fields are involved in the **Update Domains** process:

**Table 5-1**

<table>
<thead>
<tr>
<th>Table</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignments</td>
<td>Assignment_Number</td>
</tr>
<tr>
<td>Incident</td>
<td>Incident_name</td>
</tr>
<tr>
<td>Clue's point</td>
<td>Clue_Number</td>
</tr>
<tr>
<td>PLS</td>
<td>Victim_Number</td>
</tr>
<tr>
<td>Teams</td>
<td>Team_name</td>
</tr>
<tr>
<td>Operational_Period</td>
<td>period</td>
</tr>
<tr>
<td>Search_Segments</td>
<td>Area_name</td>
</tr>
</tbody>
</table>

Unfortunately, having unique values can’t be enforced in several of the attribute table fields, so it’s possible to enter duplicate values. Assignment numbers, for instance, automatically ascend incrementally by 1 after you enter the first assignment number. So, once you enter “1” as your first assignment, 2 will automatically appear when you create a new **assignment**. The same is true for **Operational Period**. Other tables and fields,
though, can contain unenforced, duplicate values. Reading the error message will help you determine which table or field is causing the error.

So although the numbers of an assignment, for instance, automatically ascend incrementally by 1 after the first entry, the number can be overridden by the user creating a duplicate. When this happens, **Update Domains** will show an error. This example will demonstrate entering two assignments with the same assignment number to create the error and show how to resolve it.

The attribute table below contains two assignments, each with an assignment number of 1.

**Start editing**, then open the **Assignments** table in the TOC. Enter the number 1 in two rows of the Assignment column. **Save** edits and run **Update Domains**.

Now, run the **Update Domains** tool.

**Stop and read the error.**

![Figure 5-36](image)

You can see that the table being read was Assignments, and the error states, **“Domain value 1 description 2 already exists as description1.”** This is your cue to review that attribute table, find and resolve the duplicate values, save edits, and rerun the tool.
Fixing the Update Domains Button

If the Update Domains button stops working, you can still run the Update Domains tool by clicking the actual tool from the Catalog window: Expand Home > SAR_Default.gdb > SAR_Toolbox.

Double-click Update_Domains. You will get the message, “This tool has no parameters.” Click OK, and the tool will now run.
Replace the Update Domains button with one that works.

Open the **Customize** dialog box by clicking **Customize** > **Customize Mode**.

With the **Customize** dialog box open, remove the nonworking button by clicking it and dragging it off the menu bar.

Click the **Commands** tab.

In the **Categories** box, click **Geoprocessing Tools**.

If **Update_Domains** is listed in the **Commands** box, select it and click the **Delete Tool** button.
Next, click the Add Tools button. Navigate to SAR_Toolbox and select Update_Domains.

Click Add.

Update_Domains should now appear in the Commands box. Drag it up to your menu bar. Place it to the left of the GPX Importer tool button.

Close the Customize dialog box.
Appendix 1: Attribute Assistant in MapSAR

Attribute Assistance (AA) is used to automate several tasks and is the basis of how MapSAR works. Below is the current table of rules that AA executes.

![Figure A1-1](image)

These values, or rules, are kept in the DynamicValue table. This table must exist for AA to work correctly.

Another table is used to store values to make assignment and operational period numbers ascend incrementally. This is the GenerateID table. Again, this table must be present for AA to execute successfully.

![Figure A1-2](image)

AA must be running. It is running if the square button next to the Editor menu on the toolbar is green. If it’s not green, toggle or click the button. If you don’t see the AA icon, please refer to the installation documentation. You may need to reinstall AA.

![Figure A1-3](image)

If you need to add/edit values or reset counters for any reason, the tables can only be viewed in the List by Source view in the TOC. Just above the TOC pane is a toolbar. Each button allows a different view of the layer files: List by Drawing Order, List by Source, List by Visibility, and List by Selection.
Click the **List by Source** button, then **open** as you would any attribute table.

![Figure A1-4]

![Figure A1-5]
Appendix 2: Creating Bookmarks

Here’s an additional tip for using MapSAR often in the same areas of interest: Add bookmarks for the places your team most commonly works in; this way, they’ll be quickly available whenever you start a new incident.

Internet access is required for this next step.

1. If MapSAR.mxd is not already open, open it now. Next, select File > ArcGIS Online.

2. Type “topo” in the search box. Select a topo map that has an Add button rather than Open. Click Add. Alternatively, you might find that World Street Map also works well as a basemap choice.

3. Navigate to the first area of interest. You may want to zoom out to 1:10,000,000, pan around, then zoom in to your area of interest. In this screen shot, the scale is set to 1:24,000. Use the Pan and Zoom tools to navigate to Chantry Flats.
4. Click **Bookmarks > Create.**

A. Give your bookmark a name that’s meaningful to you and your team. Note that bookmarks store the scale, so you might want to create several bookmarks of the same location at different scales.

B. Create as many bookmarks as you think will be useful.
5. Click **Bookmarks > Manage.**

![Figure A2-9](image-url)

6. Click **Save All** and give the map set a name to save bookmarks at the root of MapSAR (C:\MapSAR), but store them wherever you wish.

![Figure A2-10](image-url)
Load Your Bookmarks into Each Template
1. In the MapTemplates folder, open a new map template by double-clicking it.
2. Click Bookmarks > Manage.
3. Click the Load button.

![Figure A2-11](image1)

4. Navigate to your stored bookmark file and click Open.

![Figure A2-12](image2)

Using this method, you can create and store groups of bookmarks for many areas. Load them into each template, or simply store the bookmarks and load them as needed.

![Figure A2-13](image3)
Creating the Customized New_Incident File

1. Once you’ve added bookmarks to all the MXD map templates, it’s time to create a compressed package that can be extracted for each new incident so it will always be specific to your area’s UTM zone.

2. Close MapSAR and any running copies of ArcCatalog or ArcMap.

3. Select the New_Incident folder you’ve just customized for your areas of interest, using the correct UTM zone.

4. Right-click the folder and select Winzip > Add to New_Incident.zip. Or you can use your default compression utility by right-clicking and choosing Send To > Compressed (zipped) Folder.
After processing, you will have a new master New_Incident.zip file.

![Folder structure](image)

Figure A2-16

This is your customized and localized version of MapSAR.
Appendix 3: Cell Phone Pings

Plotting cell phone pings can be a complex process, depending on the data you receive. It is also fraught with uncertainty. The data you derive should almost always be treated only as probability areas to search and never as exact locations of a person. All requests for cell phone information must originate as an Exigent Circumstances request from your local law enforcement. Communications Assistance for Law Enforcement Act of 1994 (CALEA) defines the statutory obligation of telecommunications carriers to assist law enforcement in certain circumstances, so make sure you are involving law enforcement to obtain the information you need. It is important that you develop a relationship with the cellular carriers in your area and understand their information needs and capabilities well before any actual incident. Research this topic and work with other SAR groups and law enforcement to familiarize yourself with the capabilities of both cell phone types (e.g., GPS-enabled vs. network-based location information) and the cellular network providing the information. In Using GIS in SAR for Emergency Responders, the Google Group has compiled resource materials on not only cell phones and networks but also other location-based signaling devices. Also, refer to the cell phone section in Robert Koester’s Lost Person Behavior for best practices in trying to obtain location data from a caller. Civil Air Patrol also has a limited number of cellular forensics technical specialists, whose assistance you may be able to tap into during an incident—again, make these contacts as part of your preplanning activities.

Here are a couple of different methods of locating cell towers and then obtaining and visualizing their coverage area. In this example, straight distance will be used without plotting elevations or obstacles that might interfere with the cell signal.

The following describes two ways of finding cell towers. The first is where the cell provider has given you the coordinates of the tower and the distance that signal can potentially travel.

The second will be when you get an address of a cell tower. Publicly available data will be used to locate the tower and then plot the signal distance.

If You Have the Cell Tower Coordinates

In this first example, the cell company has provided the coordinates of the tower; signal range is 12.5 miles as the crow flies.

Coordinates are in degrees, minutes, seconds (DMS), and the Datum is NAD83: 36° 43’ 30” by -118° 56’ 35”.

Click Editor > Start Editing.

![Figure A3-1](image.png)
In the TOC, make sure that both the 6 Clues layer and Cell_Pings are checked so that the Create Features templates will be visible on the right.

Click the Cell_Pings template.

Then, right-click anywhere on the map and select Absolute X, Y. This will display the coordinates dialog box. Select Degrees Minutes Seconds for a coordinate system.
Enter the coordinates. You can enter them without the degrees, minutes, seconds notation, but use spaces between each. Be sure to note “W” and “N” for North America or the appropriate direction from the prime meridian for your location.

![Absolute X Y]

Press the Enter key. Note that if coordinates are not entered in the exact format required by ArcGIS, the point will not be created.

You may or may not see the cell tower location on the screen, depending on the current extent you’re viewing. It’s okay if you don’t see the tower.

Next, right-click the Cell_Pings layer in the TOC window and select Open Attribute Table.

![Cell_Pings]

If you entered the coordinates correctly, in the attribute table you’ll see a new row that should be selected (blue). If you don’t see an entry, check the coordinates and reenter them in the ArcGIS format.
Complete the entries. Set **Display** to True if you want to see the tower on the screen or to False if you don’t. This is useful if you have many towers and only want to display a particular one.

**If You Have the Cell Tower Address**

To use this information, you’ll need to have street addresses or, better still, cell tower location data. You can acquire the cell data free from [http://wireless.fcc.gov/geographic/index.htm](http://wireless.fcc.gov/geographic/index.htm). It is suggested that you download and process this data well in advance of any incident.

Add your cell tower data to the basemaps layer and make sure it’s above any raster basemaps, or you won’t see the towers.

Use the Tower icon to symbolize this data layer.

The first part of the process is as above.
Start editing.
Make sure **6 Clues** and **Cell_Pings** are selected and that you can see the **Cell_Pings** template in the **Create Features** window on the right.

Next, click the **Find** button on the toolbar.

![Figure A3-12](image)

Select the **cell tower** layer you’ve previously loaded.

![Figure A3-13](image)

The address given by the cell provider is Kings Canyon National Park, Wilsonia, Tulare, CA.

Use this information to search for the tower.

Enter “Kings Canyon National Park”. A single tower is displayed:

![Figure A3-14](image)

Right-click the resultant tower location and select **Identify**.
A window will appear, containing all the information about this tower. Verify that it’s the tower you’re looking for.

Right-click the tower ID and select **Pan To**. This will center the tower on your map.

Now you need to transfer the location of this tower to the **Cell_Pings** layer. Use a simple copy and paste function to accomplish this.
In edit mode, click the Editor drop-down arrow.

![Editor](Figure A3-19)

Drag a small rectangle around the tower to select it. You’ll know by the blue highlight when it’s selected.

![Figure A3-20](image)

On the Edit menu, click Copy.

![Figure A3-21](image)

Next, be sure that the Cell_Pings layer and template are visible in the Create Features window.

![Figure A3-22](image)

Click the Cell_Pings template to select it, then click Paste on the Edit menu.

![Figure A3-23](image)
A dialog box will appear, confirming where the feature will be pasted.

Verify the target is Cell_Pings, and click OK.

![Paste dialog box](image)

Figure A3-24

A new feature will be listed in the Cell_Pings layer.

If you’re looking to create a range circle from this tower, also paste a copy to the Scratch_Point layer. Use the same copy and paste technique as above; just select the Scratch_Point layer as the paste target.

### Drawing a Signal Range Circle Around the Cell Tower

As with most tasks in ArcGIS, there are several ways to accomplish this. Here are two methods.

**Hand Drawing a Circle Using the X,Y and Radius Functions**

Start editing. Be sure 7 GPS_Tracks_And_Routes and Scratch_Lines layers are selected (checked).

![Layer selection](image)

Figure A3-25

**Scratch lines** and **scratch points** are used to store nonspecific point and polygon data and can be used for a variety of tasks. **Scratch_Lines**, a polygon feature class, will be used in this example.

By now, you should already know the location of the cell phone tower and the approximate distance the signal will travel. If you don’t have the exact x,y coordinates, but know the location of the tower, you will need the range to draw the signal circle.
Select the **Scratch_Lines** template.

If you're using x,y coordinates, right-click anywhere on the map and enter the coordinates. If you're going by an eyewitness verbal description of the location, use the **Pan** and **Zoom** tools to find the location on the map.

If you're using an eyewitness verbal description of the location, click on the map where you want to establish the center of the circle.

For coordinates entry, select **Absolute X, Y**. Select the coordinate system, add the coordinates, and press **Enter** to center the circle.

Next, right-click and select **Radius**.
Enter the number in meters of the circle size you wish to draw.

Press Enter.

You can give this feature a description in the Scratch_Lines attribute table.

Stop editing and save your edits.

Use the Euclidean Model to Generate a Signal Circle Around the Cell Tower

The Euclidean model takes input from a point feature class; it will use each feature as an input and apply the circle to each feature.

Drawing Bearing Lines (DF = Direction Finder)

Start editing.

Make sure you have 6 Clues and DF_Bearings_All checked so that the Create Features template is visible on the right.
The templates are given symbolized colors to show relative signal strength.

To enter a signal, you'll need the point from which the bearing was taken, the bearing angle, and the relative signal strength.

For this example, enter a very strong signal at 253 degrees that was taken from UTM 11N 325993 northing and 4066001 easting with a datum of NAD83.

Before entering those coordinates, it’s advisable to zoom out from your map to a larger scale. The reason for this will become clear later. For this example, zoom out to 1:100,000.

![Figure A3-37](image)

Select the appropriate signal strength symbol.

![Figure A3-38](image)

Then, right-click on the map and select **Absolute X, Y**.

![Figure A3-40](image)

This will display the coordinate dialog box. Select the appropriate coordinate system, in this case, **UTM**.
Enter the coordinates exactly as ArcGIS requires. Press Enter. If you enter incorrectly (e.g., not enough numbers), you won’t receive an error message; the feature simply won’t be drawn.

This will anchor the starting point of your line.

Next, right-click again; this time, select Direction.

The Direction dialog box will be displayed. Enter the correct bearing in degrees, and press Enter.

This will constrain your line so that it can only be drawn on this bearing. If you’re getting a strange bearing result, check the MapSAR First-Time Setup section in Chapter 1 and verify that you have set the default geometry to North Azimuth and Decimal Degrees.

Now draw the line out as far as necessary. Double-click to complete the line.
Next, right-click the **DF_Bearings_All** layer and select **Open Attribute Table**.

![Open Attribute Table](image1)

You’ll see the feature you just created. Fill in the fields as completely as you can.

![Figure A3-46](image2)

Enter as many bearings as necessary.

**Stop editing, save your edits, and save the project.**

![Figure A3-47](image3)
Appendix 4: Resources and Support

Because the use of GIS in search and rescue is such a new discipline, resources and information are obtained from a number of publications, online sources, and individuals. While one of the goals of this manual is to provide a single source for much of this information, GIS users will find that they will always have to track down resources to meet their particular needs. Here’s a basic list to help in that quest.

Resources

- **MapSAR.net**
  The website for the latest MapSAR build contains instructional material and lists contact information for SAR people skilled in GIS and MapSAR. If you have problems or questions or need help on an active operation, you can also e-mail help@MapSAR.net. The e-mail will be forwarded to several team members, so there’s a good chance of a quick response.

Remember that, while not ideal, the Internet and data files make it possible to outsource many of your mapping requirements. If you don’t have the expertise or facilities, you can work with another team or individual who does.

- **Using GIS for Wildland Search and Rescue** ([MapSAR.net](http://MapSAR.net))
  This ebook companion for the MapSAR User’s Manual includes links to the exercise data, MapSAR, and resource information.

- **Using GIS in SAR for Emergency Responders** ([http://groups.google.com/group/sar-and-gis](http://groups.google.com/group/sar-and-gis))
  Participation in this Google Group forum for SAR and GIS requires approval, which is usually quickly granted. This forum is a good place to ask questions about any problems you’re having or suggest better techniques or workflows.

- **The National Alliance for Public Safety GIS Foundation** ([napsgfoundation.org](http://napsgfoundation.org))
  The research and education foundation furthers the effective use of GIS in emergency services.

- **Esri.com**
  An excellent resource for all things GIS and ArcGIS, Esri offers online support with a number of options: access to its forums, where you can ask questions of other users; extensive, up-to-date help topics on all aspects of ArcGIS software; product help for licensed users (depending on the license level); and an extensive collection of specialized scripts that automate or enhance many GIS tasks.
• ArcGIS Online (arcgis.com)

This site offers a source for community and Esri geospatial data and allows user groups to share data. One application of ArcGIS Online might be to share the data of an active SAR with geographically separated command posts or another team helping in analysis or SAR mapping. Account creation is required.
Appendix 5: Glossary and Acronyms

**Assets**—Resources, either equipment or personnel, used in the SAR operation (for example, SAR dog team, helicopter, transportation).

**Assignments**—Tasks given to SAR resources to be completed within a given operational period.

**Attribute Table**—A database that contains information about a set of geographic features. Typically arranged in rows and columns where each row represents a feature and each column represents a single feature attribute.

**Create Features Template**—Allows the use of construction tools to create points, lines, or polygons in the map document. Active only in Edit mode.

**Domains**—The rules that describe the legal values of a field type in an attribute table. This is used to ensure that the values used are within an acceptable range.

**Esri**—Developer and distributor of ArcGIS products, including ArcMap.

**Feature Class**—Collection of features having the same spatial representation, such as points, lines, and polygons, as well as a common set of attribute columns.

**Georeferenced**—An object whose location has been defined and established using a coordinate system and/or map projections.

**Georeferencing**—Defining and establishing the location of an object in physical space.

**GISS**—Geographic Information System Specialist. In a wildland fire, this is a qualifying position with training and a task book. Not established in SAR yet.

**GPS**—Global Positioning System, a space-based satellite navigation system used to provide location and time information anywhere on earth. The system requires an unobstructed line of sight to four or more GPS satellites that are in a geosynchronous orbit around the equator.

**GPX**—GPS eXchange Format, an XML schema used as a common GPS data format. It is used to describe waypoints, routes, and tracks as well as to store time, location, and elevation data.

**Graticule**—Grid of intersecting lines that maps are drawn on, such as latitude and longitude.

**ICP (sometimes known as CP)**—Incident Command Post, the location at which the primary command functions are carried out. The ICP may be shared or located with the base or other incident facilities and is typically located at or in the immediate vicinity of the incident site. There is only one ICP established for each incident.
IPP—Initial Planning Point, where the initial focus of the search is centered. This may also be the PLS. The IPP may be used in the absence of a PLS. Once established, the IPP does not change.

Operational Period (OP)—The period of time scheduled for the execution of the incident action plan. Operational Periods can be of any duration but typically are 12 hours long and usually do not exceed 24 hours.

PLS—Point Last Seen, where the missing person was seen by a person or recorded on a device such as a CCTV.

Point Feature Class—Feature class containing only point representations (for example, ICP, helipads, radio relay).

Polygon—A closed series of lines that define an area.

Project/MXD—The ArcMap document that contains all the information relating to the map, including symbology and layout.

Reporting Party (RP)—The person from whom the initial information is received. This is usually the person who calls in the missing person report.

Routes—Typically, two or more connected waypoints.

SAR—Search and rescue.

Schema Lock—Occurs when more than one user is reading and editing the data at the same time.

Schema—The structure or design of a database.

Segments—A defined portion of the search area or region that is to be searched by SAR resources. The boundaries of the segment are based on the resources’ ability to complete the task.

Subject—The lost, stranded, injured, or deceased person who is the focus of the SAR operation.

Table of Contents (TOC)—Contains a list of all the data used in the map. The display window of the TOC shows how each layer is shown in the data frames. You can turn the layers on and off within the TOC, work with the property layers, and rearrange the drawing order of the layers.

Track Logs—The sequence of GPS coordinates or track points that make up the track.

Waypoints—Sets of coordinates that identify a point in physical space.
Appendix 6: References

Additional References That May Be of Interest

Research Coordination Network’s conversion utility for coordinates: http://www.rcn.montana.edu/resources/tools/coordinates.aspx.


NOAA’s state plane coordinate system (SPCS) conversion tool: http://www.geodesy.noaa.gov/TOOLS/spc.shtml.


For comments or questions about MapSAR, contact the MapSAR project team at help@MapSAR.net or visit www.MapSAR.net.
Esri inspires and enables people to positively impact their future through a deeper, geographic understanding of the changing world around them.

Governments, industry leaders, academics, and nongovernmental organizations trust us to connect them with the analytic knowledge they need to make the critical decisions that shape the planet. For more than 40 years, Esri has cultivated collaborative relationships with partners who share our commitment to solving earth’s most pressing challenges with geographic expertise and rational resolve. Today, we believe that geography is at the heart of a more resilient and sustainable future. Creating responsible products and solutions drives our passion for improving quality of life everywhere.

Contact Esri

380 New York Street
Redlands, California 92373-8100 USA

1 800 447 9778
T 909 793 2853
F 909 793 5953
info@esri.com
esri.com

Offices worldwide
esri.com/locations